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Introduction
Cisco SocialMiner is a customer-care system that provides capture, filtering, workflow, queuing, and
reporting for social media engagement teams. Internet postings captured by SocialMiner are referred to as
Social Contacts. SocialMiner stores the social contacts and groups them into user-defined Campaigns. Each
Campaign obtains social contacts from one or more Feeds. SocialMiner presents the social contacts to social
media customer care personnel who can search, review, categorize, and respond to the postings. SocialMiner
also produces reporting metrics on the handling of the social contacts.
SocialMiner has one default user, called the SocialMiner Administrator. The SocialMiner Administrator is
the Application User who is configured during installation. The credentials for that user allow initial access
to SocialMiner. Certain SocialMiner functions are available only to the SocialMiner Administrator ?
Introduction
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including access to Active Directory on the Administation tab, where the SocialMiner Administrator can set
up other users.
Back to Contents

Technology and Packaging
SocialMiner is a server software application that is packaged as a software appliance. The appliance runs as
one VMware® virtual machine containing all of the following components:
• Cisco Unified Communications Operating System (Unified OS), an operating system based on
Redhat Linux.
• Informix® embedded database. This database contains the SocialMiner Configuration and the
SocialMiner reporting data.
• Cassandra datastore. This datastore contains the social contacts.
• Solr indexer. This indexer contains social contact search data.
• Cisco SocialMiner runtime software
• OpenFire server for XMPP BOSH eventing
Setup and administration are done through a browser-based interface that uses OpenSocial Gadgets.
SocialMiner is installed with the Shindig gadget container to render the gadgets. SocialMiner gadgets can
also be rendered in other standard OpenSocial containers. All system features and setup can be performed by
REST APIs.
SocialMiner supports integration with most user-generated content sites using standard RSS. SocialMiner
also supports direct integrations to Twitter® and Facebook®. Setup and configuration of SocialMiner to
monitor Twitter and Facebook require good working knowledge of those sites. For background information
on these sites, review the following Mashable resources:
The Twitter Guide Book
The Facebook Guide Book
Back to Contents

What's New in Release 9.0(1)
Cisco SocialMiner Release 9.0(1) includes these new features and enhancements:
Cisco Options Package
New
A third Cisco Options Package file is available that introduces a new feed type for the Twitter Search
functionality which enables users to continue searching for specific Tweet threads. This change was
prompted because Twitter no longer provides search results in the form of an RSS feed. This third COP file
is cumulative and includes the fixes addressed in the previous 2 COP files for release 9.0(1)
UCCX integration
SocialMiner release 9.0 is now integrated with the Unified Contact Center Express (UCCX) solution for
single session chat.
What's New in Release 9.0(1)
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Deployment size options
SocialMiner can be configured in two deployment profiles: small (30 social media users and 120 chats) and
large (60 social media users and 400 chats).
Live Chat
The SocialMiner Chat interface now supports low-vision accessibility through JAWS. This feature is enabled
and disabled using the ctrl+shift+s keyboard shortcut for customer chat sessions and through a checkbox on
the agent settings page for agents.
Once enabled, incoming chat messages and other events are automatically highlighted briefly and can then be
announced by JAWS.
Users can now change the font size in their chat interface; keyboard functions allow all users to increase
(ctrl+shift+]) or decrease (ctrl+shift+[ ) font sizes in chat.
The keystroke combination ctrl+shift+E ends the chat and closes the agent chat interface.
Chat timeout settings are adjustable.
Social Media Features
Users can search to find social contacts by author, by status, within a certain date range, or containing
specific words.
Agents have the capability to save drafts of social contact replies (for Facebook and Twitter) and have them
reviewed before they are released.
A disk usage meter has been added to help monitor disk capacity.
Status change reason codes have been added. When a user hovers over the status indicator of a social contact,
a tool tip appears telling them the reason that the social contact is in its current state.

Installing or Upgrading to SocialMiner Release 9.0(1)
Users can install SocialMiner Release 9.0(1) directly or they can upgrade to Release 9.0(1) from release
8.5(5).
Installing SocialMiner 9.0(1)
Before upgrading to release 9.0(1), users must perform a DRS backup to ensure that they can revert to release
8.5(5) if necessary.
Upgrading using Cisco Unified Operating System Administration
Upgrading using the CLI
Installing Cisco Options Package Files

Installing or Upgrading to SocialMiner Release 9.0(1)
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Installing SocialMiner 9.0(1)
SocialMiner is installed as an appliance using the Cisco Unified Communications Operating System (Unified
OS). The operating system and SocialMiner application are installed together using a similar installation
process as other Unified OS products such as Cisco Unified Communications Manager and Cisco Unified
Intelligence Center.
SocialMiner operates on a VMware Virtual Machine on hardware that is running a VMware Host Server.
SocialMiner currently supports installation of only a single node.
Note: Cisco does not support changing the hostname or IP address on any server once they have been set.

Basic Installation Steps
1. Create a VM using an OVF template (when deploying the template, select either a large or a small
deployment from the drop-down list) by following the instructions in Design Guidance (the OVA is number
1.2 under Latest Releases and is located in folder 9.0(1)). Additional information for using the OVF template
can be found at VMWare Hub.
2. Mount the SocialMiner DVD (or ISO file) to the Virtual Machine and set the Virtual Machine to Boot
from the SocialMiner DVD. The Install Wizard opens. Use Tab to navigate between elements and then tap
the Space bar or Enter key to select the element and proceed.
3. Perform the Media Check when prompted.
4. Several informational windows open. Select Yes or Continue.
5. Use the arrow keys to highlight the correct timezone, and then tab to navigate to the OK button. Press
Enter to proceed.
6. Provide the network information for SocialMiner. A valid host name with matching IP address must be
provided. The system confirms that the host name matches the IP address later in the installation process.
7. Select yes to provide DNS Client Settings for SocialMiner. Provide DNS servers and the domain. Select
OK.
8. Provide an Administrator ID and Password. This user is for platform (Unified OS) administration.
9. Provide information about your organization. This information generates the security (SSL) certificates for
this server.
10. You must provide at least one NTP Server. Enter the NTP host address and select OK.
11. Provide a security password. This password is typically used to communicate between multiple nodes;
however, SocialMiner currently supports only a single node.
12. Provide a username and password for the SocialMiner administrator. Additional SocialMiner users can be
imported from Active Directory after the SocialMiner install finishes.
13. The confirmation window opens. You can select Back to change settings or OK to complete the
installation. Installation can take up to 60 minutes. The server may reboot to complete the installation steps.
If you install from an ISO file and see a Virtual Machine message instructing you to Disconnect anyway (and
Installing SocialMiner 9.0(1)
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override the lock)?, select Yes.
After installation finishes, a login prompt appears in the server console.

Post-installation Setup
After the installation is finished, perform the following one-time setup tasks:
1. If your system is installed behind a firewall, set up a proxy so that feeds can access sites on the Internet.
2. Configure Active Directory so that additional users can log in.
3. Set up the Reporting User so that reporting tools can access the reporting database.

Upgrading using Cisco Unified Operating System Administration
You can upgrade using the Software Upgrades tool in Unified Operating System Administration. You can
also upgrade using the Command Line Interface CLI.
Before upgrading to release 9.0(1), users must perform a DRS backup to ensure that they can revert to release
8.5(5) if necessary.
The upgrade can run unattended and may take over an hour.
Open Cisco Unified Operating System Administration from the Administration tab > Platform
Administration. You can also use this URL
http://<servername>/cmplatform

where servername is the Hostname or IP address of your SocialMiner server.
1. Select Software Upgrade > Install/Upgrade.
2. On the Software Installation/Upgrade dialog box, if you burned the files to CD/DVD:
1. Source = DVD/CD.
2. Directory = the directory for DVD/CD. Use forward slashes. For example, if the upgrade file
is located on the root directory of a CD that is on Drive D, type /D.
3. Server = leave blank.
4. User Name = leave blank.
5. Password = leave blank.
3. On the Software Installation/Upgrade dialog box, if the upgrade files are on a remote file server:
1. Source = Remote Filesystem.
2. Directory = the path to the files. Use forward slashes. For example,
/SocialMiner/Installation.
3. Server = the IP address of the remote server.
4. User Name = the user name to access the remote server.
5. Password = the password to access the remote server.
4. Click Next.
5. Choose the iso file from the Software Location field.
6. Click Next.
7. At the Software Installation/Upgrade screen, select Reboot to Upgraded Partition.
8. Click Next.
You see a series of messages as the upgrade installation proceeds.
Basic Installation Steps
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When the upgrade is complete; verify that the system restarts, the correct version is active, and the server
status on the System Administration tab shows green checkboxes.
Turn off CSA by performing these steps.
As a best practice, clear the cache and cookies after the upgrade.
Back to Contents

Upgrading using the CLI
Before upgrading to release 9.0(1), users must perform a DRS backup to ensure that they can revert to release
8.5(5) if necessary.
1. Download the 9.0(1) SocialMiner release from Cisco.com and place the file on an FTP or SFTP
server. You can also burn the ISO file to DVD.
2. Using SSH, log in to your SocialMiner system with the platform administration account.
3. Using the CLI, run the command utils system upgrade initiate.
4. Follow the instructions provided by the utils system upgrade initiate command.
An example of executing the command follows. Note that file names change with each release.
admin:utils system upgrade initiate
Warning: Do not close this window without first canceling the upgrade.
Source:
1)
2)
3)
q)

Remote Filesystem via SFTP
Remote Filesystem via FTP
Local DVD/CD
quit

Please select an option (1 - 3 or "q" ): 2
Directory [q]: /FTP/PATH/TO/UPGRADE/IOS
Server [q]: FTP_HOSTNAME
User Name [q]: FTP_USERNAME
Password: ********
Checking for valid upgrades. Please wait...

Available options and upgrades in "/FTP/PATH/TO/UPGRADE/IOS":
1) UCSInstall_CCP_8_5_1_UCOS_8.5.4.10000-XX.sgn.iso
q) quit
Please select an option (1 - 1 or "q" ): 1
Accessing the file. Please wait...
Downloaded XXXX MB.
Checksumming the file...
Downloaded XXXX MB.
A system reboot is required when the upgrade process completes or is canceled.
This will ensure services affected by the upgrade process are functioning properly.
Downloaded: UCSInstall_CCP_8_5_1_UCOS_8.5.4.10000-X.sgn.iso
File version: 8.5.4.10000-X
File checksum: CHECKSUM
Automatically switch versions if the upgrade is successful (yes/no): yes

Upgrading using Cisco Unified Operating System Administration
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Start installation (yes/no): yes
The upgrade log is install_log_2011-03-10.09.52.58.log
Upgrading the system. Please wait...
06/10/2011 09:53:00 file_list.sh|Starting file_list.sh|<LVL::Info>
...
[Many lines of upgrade scripts running]
...
06/10/2011 11:41:31 upgrade_install.sh|Upgrade Complete -- (0)|<LVL::Info>
Successfully installed UCSInstall_CCP_8_5_1_UCOS_8.5.4.10000-XX.sgn.iso
The system upgrade was successful.

A switch version request has been submitted.

This can take a long time depending on the platform and database size. Continue to monitor the switchover
process from the Unified Communications OS Platform Command Line Interface (CLI).
The system reboots after the upgrade.
Verify that the system restarts, the correct version is active, and the server status on the System
Administration tab shows green checkboxes.

Installing Cisco Options Package Files
The Cisco Options Package (COP) file provides a generic method to deploy Cisco software outside the
normal upgrade process. Some examples of when you use a COP file are to installnew locales, patch fixes,
and virtualization tools. You must first download and save the COP file before installing and applying it.
COP files can generally be installed on an active, running system in a shorter time frame than an upgrade file.
Unlike upgrades, COP files cannot be removed or rolled back.
Use these instructions to install COP files:
1. Download the SocialMiner COP file from the Cisco Software site
http://www.cisco.com/cisco/software/type.html?mdfid=283613136&catid=null to a local source or an SFTP
server that can be accessed by the Cisco SocialMiner server.
2. Install the file using the CLI upgrade procedure. (Remember to replace the upgrade filename with the COP
filename).
3. Reboot the server.
Note: If the ReadMe file for a specific COP file contradicts these general guidelines, follow the instructions
provided with the file.

Turn CSA off
1. Access the CLI directly by signing in using the Administrator credentials.
2. Enter the command: utils csa disable. A message informs you that the system needs to
restart and you are prompted to enter Yes.
3. Enter Yes to reboot.

Upgrading using the CLI

7

SocialMiner_Release_9.0(1)
As a best practice, clear the cache and cookies after the upgrade.
Back to Contents

Sign in to SocialMiner
To launch SocialMiner, use a web browser* to access the root of the web server. Enter
http://<servername>

where servername is the name or IP address of your SocialMiner server.
*See

SocialMiner Browsers for information on supported browsers.

Entering the URL opens a sign-in page where you type your username and password. The first time you sign
in, you must use the credentials established during the installation for the application user.
If you have downloaded and installed language files, the sign in page also has a drop-down for selecting your
language.
When you see a "trusted certificate" warning, acknowledge it?for example, by clicking Continue to Web
Site in Internet Explorer or I understand the Risk in Mozilla Firefox. This saves the certificate to the
browser. For some browsers, you can obtain and upload a CA-Signed certificate so that the security warnings
do not persist. If you don't obtain signed certificates, you can still avoid the certificate warning message.

A successful sign-in presents the SocialMiner interface to the Home tab. Users see the Search and
Configuration tabs, the SocialMiner administrator also sees an Administration tab.
Back to Contents

The Home Tab
Topics:
Reviewing Social Contacts By State
Working With Social Contacts
Searching Social Contacts
The Home Tab
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Replying to Social Contacts
Tagging Social Contacts
Settings
Train Filters

The SocialMiner Home tab is a dynamic "Inbox" for viewing and responding to social contacts. No social
contacts appear on this tab until you:
1. Configure at least one Feed.
2. Configure at least one Campaign.
3. Add the Feed to the Campaign.
4. Select the Campaign from the Please select a campaign... drop-down menu.
You can show social contacts that are in specific states (Open, Draft, Handled, or Discarded). You can also
open Settings to set your chat alias, to show only those social contacts with specific tags, or to enable training
mode for a Bayesian filter. You can also enable Accessibility in the Agent Chat UI from the Settings page.
The SocialMiner Home tab is dynamic in these ways:
• A bar appears periodically at the top of the page indicating that there are one or more new social
contacts in the campaign. You can click the bar to refresh the results, or click the refresh icon in the
upper-right corner of the window.
• State changes and new tags made by one agent are immediately visible to all agents working in that
campaign.
VIDEO: View a video about handling social contacts on the Home tab. Although this video was created for
an earlier version of SocialMiner and shows an older user interface, it presents accurate information.
Back to Contents

What is a Social Contact?
The term Social Contact refers to a post collected by SocialMiner. A social contact can be a Chat, a Tweet, a
Facebook wall post, a Blog, or a Forum post.
For example:
1. When a customer tweets and the tweet matches the Feed criteria of SocialMiner campaign, that tweet
is captured by SocialMiner and stored in the datastore as a social contact.
2. An agent's reply to that tweet is captured and saved as another social contact.
3. The customer reply to the agent's reply is captured as a third social contact.
A social contact remains in the datastore until it is purged.
What is a Social Contact?
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SocialMiner stores the following for each social contact:
• Author?the username of the person who posted
• Creation Date?date stored in SocialMiner
• Title-the title of the post
• Description-the nature of the social contact text
• Published Date?date it was published on the Internet (Not all feeds have this.)
• Source type?the type of feed that collected the social contact
• Tags?tags applied by SocialMiner users
Back to Contents

Reviewing Social Contacts By State
A social contact can be in one of five states: Unread, Reserved, Draft, Handled, and Discarded. Use the
drop-down on the Home tab to show contacts in a specific state:
Show Open - Open social contacts are those in the Unread or the Reserved state that have not yet been acted
on. All social contacts captured by SocialMiner are initially in the Unread state.
Show Draft - Displays the Twitter and Facebook social contacts that have had draft responses saved for
review, but the responses have not yet been sent.
Show Handled - These social contacts have been handled by an agent. If the social contacts are from an RSS
feed, the agent has opened them. If the social contacts are from a Twitter or Facebook feed, the agent has
replied to them.
Show Discarded - These social contacts have been discarded either by an agent (perhaps because no
response was required) or - for chat social contacts only - by the system (if the maximum number of
simultaneous chats has been exceeded). Discarded contacts remain in the system until they are deleted by the
next purge. (Administrators can find the total amount of system-discarded chats using the Serviceability
API.)
When a user hovers over the social contact state indicator, a tool tip opens to say why the social contact is in
that state.

Working with Social Contacts
A social contact state can be changed by any user by clicking the social contact state button. The name of the
last user to change a state appears next to the social contact as soon as the change occurs: for example,
Discarded: User2.
State changing can be done by different agents. For example, Agent1 can reserve a social contact, and
Agent2 can handle it.
To undo a state change; show the list for that state, locate the social contact, and click the icon again to
reverse the state.
For example, if you set a social contact to Handled and then change your mind about handling it:
1. Select Show Handled.
2. Locate that social contact.
Reviewing Social Contacts By State
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3. Click the Handle icon. This removes the social contact from the Show Handled list immediately. The
social contact is returned to the Show Open list within a few seconds with an Unread status.
Social contact state is universal across the SocialMiner system. For example, if one user handles a social
contact, the social contact appears as handled in the browser interface for all other users. This also occurs if
the social contact appears in multiple campaigns.
When a chat session ends, the state change buttons for the Social Contact become inactive and are greyed
out.

Back to Contents

Searching Social Contacts
The Search tab enables users to search for specific social contacts on SocialMiner.

Open the search interface by clicking on the Search tab and type text into the search box for a default search
of all fields. Wildcard-based searches using "?" (for a single character) and "*" (for multiple characters)are
allowed.
When you start to type, a drop-down list of searchable fields is presented. Select the specific field you wish
to search and enter a term (or more than one term enclosed in quotes) beside the field name.
Certain characters are special and cannot be included in the default search unless they are escaped -- meaning
either enclosing them in quotes or proceeding them with a backslash. For example, if you want to include the
character + in your search, you need to enter \+ or "+". The same is true for the colon (:). For example, to
include a URL starting with http:// in your search, enter http\:// or http":"// to have it recognized. (For a full
list of all special characters, see the Solr wiki.)
SocialMiner also allows for a combination of default and field-specific searches using AND and OR
operators.
For example, to search for a social contact that contains the phrase "This is a test social contact" and is
authored by John Smith, you can search on:
• sc.author:John* (wildcard in field-based search)
OR
• sc.author:"John Smith" AND test social contact (a mix of field-based search and default search)
OR
• test social (just the default search)

Working with Social Contacts
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Search results are displayed similarly to campaign results. There is more information displayed in both the
search and campaign results for Chat social contacts than other social contact types.

The title of any Chat social contact is an active link if a transcript has been saved. Click on the link to open a
window displaying the chat transcript. (The chat transcript only becomes available once a chat session is
closed. If one party in the chat does not close their window, then the system cannot generate the transcript
until the inactivity timeout expires.)

Back to Contents

Replying to Social Contacts from the Home Tab
SocialMiner lets you reply to social contacts using Reply Templates. There are three system-defined
templates: Cisco Twitter, Cisco Facebook, and Cisco Chat. The SocialMiner Administrator can add custom
reply templates.
You can select only one reply template per feed on the Add/Edit Feed page for each Feed Type.
• Replying to a Chat
Searching Social Contacts
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• Replying to a Twitter Social Contact
• Replying to a Facebook Fan Page
• Replying to an RSS Social Contact

Replying to a Chat
When a customer submits a chat form, a new social contact opens in the chat campaign, and the customer
enters a chat room and waits for an agent. The agent who clicks the Reply icon for that social contact
launches the Chat reply template and enters the chat room where the customer is waiting.
The agent types in the text-entry area and presses Enter.
The customer sees the agent's message and enters a response.
To reply to a chat using the Cisco Chat reply template:
1. Select a social contact generated from a chat. Click the Reply icon. The chat room opens to show the
customer's name and any Extension Field data in the left panel.
2. Type a remark in the lower right panel and press ENTER to begin the dialog.

Replying to a Twitter Social Contact
There are multiple ways to reply to a Twitter social contact:
• Direct-message the author of the Tweet.
• Create an "@" reply that is viewable to everyone on Twitter.
• Configure the feed to respond with the Cisco Twitter reply template, which lets you follow the
recipient of the message if you are not currently following them.
To reply to a tweet using the Cisco Twitter reply template:
1. Select a Twitter Account social contact and click Reply. The Cisco Twitter template opens and provides
the following fields:
• Account: Select the Twitter Account from which you are replying. All Twitter Accounts configured
on this system appear in the dropdown menu.
• Once the account is selected, the system checks the Follow status of the intended recipient. If the
account is not already following the recipient, you can click Follow to begin following.
• The conversation history of the social contact is listed below the selected social contact. You can
reply, retweet, or Direct Message to any tweet in the conversation. The social contact that was
originally reserved is marked as handled even if you do not reply to the most recent tweet in the
conversation. The status of the other social contacts (tweets) in the conversation does not change.
• Select the type of reply: either Direct Message, retweet, or reply. A pop-up text box appears where
you can enter your message. Note: You can only Direct Message a Twitter user if the intended
recipient is following you. Replies and retweets are posted to the timeline of the Twitter account. A
Direct Message is sent directly to the poster of the tweet.
• Enter your reply in the pop-up text box. Text input is limited to 140 characters. The current character
count is listed at the upper right of the text box.
Replying to Social Contacts from the Home Tab
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2. Click Tweet, Retweet, or Send to send the response (depending on the type of reply selected) or, for replies
and direct messages, click Save Draft to save the response for review and then send it later. If you save a
draft message, it is marked as Draft and can be found under the Show Drafts menu. Once the response has
been sent, the social contact is marked as Handled.
The reply template is customizable. The instructions above pertain to the default Cisco Twitter template. If
your administrator has provided a custom reply template, the steps for replying may differ.

Back to Contents

Replying to a Facebook Fan Page
To reply to a Facebook fan page:
• Click the link on the social contact to open the post or comment and enter your comment.
• Configure the feed to use the Cisco Facebook reply template and respond directly to the Fan Page
from SocialMiner.
Facebook accepts content from a Facebook Reply Template only if the person who added the Facebook Fan
Page feed received authorization from Facebook by clicking Get Post Authorization. Facebook ensures that
the user is a fan of the page and has permission to post.
1. Select a Facebook social contact. Click the Reply icon.
The Cisco Facebook Reply form opens to show
• The name of the person who posted or commented on the Facebook page
• A text area for your comment
• A Like indicator
If you have never replied, or if you have previously replied with an Unlike, the template shows Like. If you
have previously replied with Like, the template shows Unlike. You can reply without selecting Like or
Unlike.
Replying to a Twitter Social Contact
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2. Click Send to send the reply or click Save Draft to save the response for review and then send it later. If
you save a draft message, it is marked as Draft and can be found under the Show Drafts menu. Once the
response has been sent, the social contact is marked as Handled.
The instructions above pertain to the default Cisco Facebook reply template. If your SocialMiner
Administrator has created and configured a custom reply template for Facebook, the steps for replying may
differ.
Back to Contents

Replying to an RSS Social Contact
You cannot reply directly to a social contact from an RSS feed. You can, however, tag the RSS contact and
set notifications so that an agent receives an email or an Instant Message for the social contact.
Back to Contents

Tagging Social Contacts
Tags are labels that allow you to categorize social contacts, to track workflow, and to set up notifications.
For example, all social contacts that mention billing concerns could be tagged with Billing. You could then
set up notifications to email social contacts with that tag to Customer Service.
You can tag similar social contacts with the same tag, then use the Settings page to filter the list of social
contacts to show only social contacts with a particular tag.
Back to Contents
Adding Tags
When you hover over a social contact, you see a text box and a Tag button.
To enter a tag, click the text box and type the tag. Then press Enter or click Tag. The new tags are
immediately visible to all users who view that social contact. You can add a maximum of 20 tags to a social
contact. Use commas to separate multiple tags.
Social contacts are not duplicated even when they appear in multiple campaigns. When a user tags a social
contact in one campaign, the tag appears to other users who are viewing that social contact from another
campaign.
Back to Contents
Suggested Tags:
A maximum of 10 common or recently used tags for the selected campaign appear as 'suggested tags' links to
the right of the Tag button. You might need to click Refresh to see newly-added suggested tags. To add one
or more of these suggested tags to the social contact. click the link for the suggested tag. These suggestions
provide one-click tagging for commonly used tags. The suggestions are specific to the campaign, not to the
entire SocialMiner system, and are only updated on a refresh.
Back to Contents
Tagging Social Contacts
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Deleting Tags
To delete a tag from a social contact, click the small, grey x at the right of the tag name.
Automatic Tags You can also configure up to 10 automatic tags for a feed. All social contacts pulled in for
that feed have these auto-tags. See Automatic Tags for Feeds.
VIDEO: View a video about using tags. Although this video was created for an earlier version of
SocialMiner and shows an older user interface, it presents accurate information.
Back to Contents

Settings
Click the Settings icon at the top right of the Home tab open the Settings page.

Use this page to set your chat alias, to enable or disable the Accessibility feature on the agent chat interface,
to show or hide social contacts by tag, and to enable training for a Bayesian filter.
The default chat alias value "Agent" can be changed to a string of up to 40 characters (stored in the browser
as a cookie). Agents use this value to define how they will be identified to users.
The Chat interface supports accessibility by using the JAWS ?highlighted text? functionality. With JAWS
configured to read highlighted text and Accessibility mode enabled, incoming chat messages and other
events are highlighted briefly so JAWS can announce them.
Click on the check the box to enable or disable the Accessibility feature in the agent chat interface.
Although tags and Bayesian filters are global (all users can see them), settings are user-specific. Your
changes to Settings determine what you see for the campaign but do not do not effect what others see in the
campaign.
Back to Contents

Settings
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Training Bayesian Filters
If you have added a Bayesian filter, you can select it on the Settings page to activate training mode.
None is the default on the Settings page. Selecting a Bayesian filter enables filter training and changes the
campaign display on the Home tab to show Plus (+) and Minus (-) training buttons for each social contact.
• Click the Plus button to mark the social contact as being "in" this filter. (This tells SocialMiner: Keep
social contacts similar to this one. Do not filter out social contacts like this.)
• Click the Minus button to mark this social contact as "out" of this filter. (This tells SocialMiner: Do
not include social contacts like this one.)
To disable training mode, return to the Settings page and select None.
Training settings are user-specific. Your changes to enable training mode do not effect what others see for
the campaign.
Back to Contents

Feeds

SocialMinerfeeds854.png
Topics:
• Feed States
• Adding and Editing Feeds
• Adding Feeds using the Feed Bookmarklet
• Feed Types
♦ RSS and Authenticated RSS Feeds
♦ Facebook Fan Page Feed
♦ Push Feed
♦ Chat Feed
♦ Twitter Account Feed
♦ Twitter Stream Feed
♦ Twitter Search Feed
• Polling Interval for Feeds
Feeds
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• Minimum Age for Feeds
• Automatic Tags for Feeds
• Extension Fields in Push and Chat Feed Sample Code
• Deleting Feeds

The Feeds gadget is on the SocialMiner Configuration tab.
A Feed is a stream of social contacts coming from a single source. Setting up feeds is a foundational step for
your SocialMiner system. You see no social contacts on the Home tab until you configure at least one feed
and add it to a campaign.
Note If your server is behind a firewall, the administrator may need to configure SocialMiner to use a proxy
to reach the Internet. See Proxy Settings.
Note also that: SocialMiner uses a process called de-duplication to automatically remove duplicate social
contacts. For example, if a user configures several overlapping feeds that capture the same result, then
SocialMiner does not capture the same social contact twice. The de-duplication functionality relies on the
unique URL of the post. For example, each Tweet or blog has a unique URL. Before SocialMiner creates a
new social contact in the datastore, it verifies that the URL of that social contact is not already in the
datastore.
Back to Contents

Feed States
Icons are used as visual indicators to display the state of each feed. Hover the cursor over the icon to display
a tool tip that explains the state.

Adding and Editing Feeds
To create a feed, click Add in the feed list view. To edit the settings for a feed, click its name.
Select the feed type and complete the fields for the feed type. The fields vary by feed type.
Social contacts retrieved by feeds are time-limited by the number of days defined in the Purge Social
Contacts older than (days) setting of the Purge Settings tool. (This tool is on the Administration tab and is
used by the SocialMiner Administrator only.) The default is to retain social contacts for 30 days.
If you change a feed (for example, to rename it, change the URL, or change the polling interval), you do not
need to re-add it to the campaign.
Back to Contents

Adding Feeds using the Feed Bookmarklet
Bookmarklets are "smart bookmarks" that include JavaScript. Creating a feed using the Feed Bookmarklet is
a one-click method for adding feeds to SocialMiner and eliminates the need to complete fields on the Add
Feed form and to copy/paste the URL.
To get and use the Bookmarklet:

Feed States
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1. From the Feed Configuration gadget, drag the Feed Bookmarklet link at the bottom of the gadget to the
Mozilla Firefox Bookmarks toolbar. (If you click the Feed BookMarklet link directly, you see a message
instructing you to drag the link to the toolbar.) The Feed Bookmarklet remains on the toolbar unless you
delete it, although there is no reason to do so.
2. Navigate to a Twitter ad-hoc or saved Search result page or to a website with RSS feeds.
Note: Although Twitter does still support search results in the form of an RSS feed, it is deprecated by
Twitter and may be removed in the future. See the latest Release Notes and watch for notification of
any Cisco Options Package files for more information on this issue.
3. From that page, click the Feed Bookmarklet bookmark that you dragged to the Bookmarks toolbar. A
message displays if the page has no feeds.
4. If you are prompted to log in, enter your SocialMiner login credentials. You must authenticate once per
browser session.
5. For Twitter Searches, a SocialMiner window opens indicating that a feed for the search was saved, along
with the Name and URL of the feed. If the feed was not saved, you see a message indicating the problem.
6. For websites with RSS feeds, the SocialMiner window captures all feeds on the page and filters them with
icons indicating whether they are standard feeds or possible feeds.
• A green checkmark displays for standard feeds. SocialMiner qualifies RSS feeds as "standard" when
their URLs are indicated as such by the website.
• A blue question mark indicates that the feed is possibly an RSS feed, but may not be. SocialMiner
qualifies RSS feeds as "possible" when their URLs simply contain "rss", "atom", or "feed".
Some URLs may be filtered out of the list even if they meet the above criteria?for example, they will not be
captured and displayed if they include embedded scripting.
7. Click the link that you want to add as a feed. The SocialMiner window updates to indicate that the feed
was saved, along with the Name and URL of the feed. You see an error message if there was a problem
saving the feed.
8. Close and re-open the Feed Bookmarklet for each URL in the list that you want to save. You see an error if
you try to save a duplicate feed (a feed with the same Name as one that is already saved).
9. After saving a feed, navigate to the SocialMiner Configuration tab. The feed displays in the Feed gadget
list. Feed names are truncated at 85 characters.
10. Proceed as you would with any feed to edit the name, description, polling interval, and minimum age;
and to add automatic tags. RSS feeds created using the bookmarklet default to "No Reply Template". Twitter
Search feeds created using the bookmarklet default to the "Cisco Twitter" reply template.
11. Add the feed to a campaign.
Back to Contents

Feed Types
SocialMiner supports the following types of Feeds. Each feed type has unique settings, which are described
in the sections below:
Adding Feeds using the Feed Bookmarklet
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• RSS and Authenticated RSS
• Facebook Fan Page
• Push Feed - SocialMiner Administrator only
• Chat Feed - SocialMiner Administrator only
• Twitter Account
• Twitter Stream - SocialMiner Administrator only
• Twitter Search

RSS and Authenticated RSS Feeds
RSS is one of the simplest and most widely-available means for SocialMiner to capture social contacts,
because there are many forum and blog sites that support RSS. You can create an RSS feed as described
below; you can also create a feed using the Feed Bookmarklet.
SocialMiner supports the following RSS Feed standards:
• RSS 1.0
• RSS 2.0
• ATOM 1.0
The Authenticated RSS feed type is similar to RSS but requires basic authentication. The username and
password are encrypted and stored in the SocialMiner configuration database.
VIDEOS:
• View a video about adding RSS Feeds.
• View a video about adding Authenticated RSS Feeds.
Although these videos were created for an earlier version of SocialMiner and show an older user interface,
they present accurate information.
Back to Contents
About Paging from RSS Feeds
SocialMiner does not support the reading of multiple "pages" from an RSS feed. SocialMiner captures the
posts that are presented on the first (main) page returned by a site. This limitation prevents the system from
capturing posts prior to the current page of results and allows SocialMiner to capture all results going
forward as long as the site generates a page or less of results in each interval.
Some sites allow the URL to specify the number of results on a page. If you use this feature to set the number
of results to return and you also regulate the polling interval, you can optimize system performance and
reduce load on the site, while ensuring all posts are captured.
Configuring RSS and Authenticated RSS
To configure an RSS or Authenticated RSS feed:
1. Access the Feed gadget.
2. Click Add.
3. Select RSS or Authenticated RSS feed type, and enter the following fields:
1. Type?Required
2. Name?Required
Feed Types
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3. Description
4. URL?Required. This must be a valid RSS Feed
5. Username?Username for the feed. Required for Authenticated RSS feed. Not Applicable to
RSS Feed.
6. Password?Password for the feed. Optional for the Authenticated RSS feed. Not Applicable
to RSS Feed.
7. Polling Interval?Number of minutes to wait between refreshing this feed.
8. Minimum age?The number of hours old a post must be before it is included as a result. This
lets you exclude recent posts.
4. Optionally, provide Automatic Tags for the feed.
5. Click Save to save the feed.
Back to Contents

Facebook Fan Page Feed
About Facebook Fan Page Feeds
The Facebook fan page feed type captures all posts and comments published on your Facebook Fan Page
wall.
Facebook wall posts and comments are captured by SocialMiner and rendered in a time-sorted stream. This
rendering differs from the standard Fan Page layout. The goal of this layout is to ensure that 100% of the
wall posts and comments are noticed by the consumer of the results. It is more difficult to achieve this goal
when viewing the wall posts and comments directly on Facebook, as they are grouped by wall post instead of
time-sorted.
When displayed in SocialMiner, Facebook wall posts and comments are differentiated by the format of the
title:
• Facebook post from [first name] [last name]
• Facebook comment from [first name] [last name] for "[post]"
The link in the title provides a direct link to the wall post on Facebook. Note that Facebook does not anchor
comments, therefore the link takes the browser to the wall posts to which the comment refers and not directly
to the comment.
SocialMiner requires a clean Fan Page "Vanity URL". Facebook appends certain parameters to a URL
depending on how you navigated to the URL. For example, when you find the Cisco Contact Center Fan
Page through Facebook search, you see this URL: http://www.facebook.com/#!/CiscoCC?ref=ts. However
the direct URL for the fan page is http://www.facebook.com/CiscoCC. This base URL is what Facebook
refers to as the "Vanity URL". The name "CiscoCC" was registered by the administrator of this page.
Some Fan Pages have a number instead of a text name (this is not common). These are pages that have not
yet registered a Vanity URL. In this case, the URL with the number satisfies the requirements of SocialMiner
configuration.

Configuring a Facebook Fan Page Feed
To configure a Facebook Fan Page feed:

RSS and Authenticated RSS Feeds
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1. Access the Feed gadget.
2. Click Add.
3. Select Facebook Fan Page feed type, and enter the following fields:
1. Type?Required
2. Name?Required
3. Description
4. URL?Required. This must be a valid Facebook Fan page The URL must start with
http://www.facebook.com
5. Polling Interval?Number of minutes to wait between refreshing this feed.
6. Minimum age?The number of hours old a post must be before it is included as a result. This
allows you to exclude recent posts.
7. Reply template?The reply template to be used for replying to social contacts obtained from
this feed. Defaults to the Cisco Facebook Reply Template.
8. Optionally, provide Automatic Tags for the feed.
4. Click Save.
5. Save redirects you to request authorization from Facebook to allow SocialMiner to access the fan
page.
6. Sign in to Facebook with your organization's username and password and then click Allow to allow
the SocialMiner to access the Facebook Fan Page.
7. Successful Authorization creates and saves the feed.

Edit a Facebook Feed
To edit a feed, simply click on the feed name, make the change, and click Save.
When you edit a Facebook feed, there are three buttons: Cancel, Save, and Reauthorize and Save.
If the icon next to a Facebook feed is red and the hover text for that icon reports authorization issues, open
the Feed as if to edit it and click Reauthorize and Save to initiate the Facebook authorization process.

Posted replies will appear as being from the user who authenticated the posting. For example, if the posting
was authorized by the Facebook account for Harrison Dental and employee Dr. Lee replies to a social
contact, her reply is from Harrison Dental and not from her own Facebook account.
Back to Contents

Push Feed
The push feed type allows you to "push" social contacts directly to SocialMiner through HTTP GET
requests. A push feed is an interface for generating a social contact through a web form. For example, you
might want to create a social contact to test the routing of email notifications. You might also want to create
a social contact for a response to a feedback form on your website.
Using the Feed gadget, create a new feed and select the Push feed type.
The SocialMiner Administrator can add, edit, and delete Push Feeds. Non-administrators can only see Push
Feeds on the Configuration tab and can use them (add them to campaigns).
1. Enter or edit the following fields.
• Type?Required
Facebook Fan Page Feed
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• Name?Required
• Description
• Reply template - The reply template to be used for replying to social contacts obtained from this
feed.
• Optionally, provide Automatic Tags for the feed.
2. Save the Push Feed.
3. Click the saved Push Feed from the list of Feeds to open it in Edit mode. You see a Sample Code link
which contains working HTML code containing the correct IP address and feed id values for the instance you
are working on. It also displays the form fields you need to get from the user and some examples of optional
fields you can include. The required fields are Title and Author. The optional fields are Description, Tags,
and Extension Fields.
In the following example, we use extension fields ?Remarks? and ?Yours?.
<style type='text/css'>span { display: inline-block; width: 100px; }</style>
<form action='http://10.86.141.251/ccp-webapp/ccp/pushfeed/100011' method='get'>
<span>'''Title''':</span><input type='text' name='title' /><br/>
<span>'''Author''':</span><input type='text' name='author' /><br/>
<span>'''Description''':</span><input type='text' name='description' /><br/>
<span>'''Tags''':</span><input type='text' name='tags' /><br/>
<span>'''Remarks''':</span><input type='text'name='extensionField_remarks'/><br/>
value='sample value' /><br>
<span>'''Yours''':</span><input type='text'name='extensionField_yours'/><br/>
value='your value' /><br>
<input type='submit' value='Submit'/>
</form>

4. Copy the code from the sample code link and save it as HTML. Edit the fields; then click Submit from the
HTML form.
The code is authenticated against SocialMiner, and a URL to the new social contact is returned. The social
contact will appear in the campaign that includes the Push Feed.

Samplepushfeed.png
If the tags in the Push feed code are associated with notification rules, the notifications will trigger
immediately when the social contact is submitted.
You can have multiple independent Push feeds on one SocialMiner system.
The Push Feed must be associated with a campaign in order to activate. As a best practice, create a test
campaign prior to testing your Push Feed.

Push Feed
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Chat Feed
A chat feed is a variation of push feed that contains sample HTML code for the fields a customer sees in a
click-to-chat request form. When the customer clicks to chat and submits the form, a social contact is created
and added to the campaign for the chat feed. SocialMiner displays a welcome screen, sets up a chat session
for that social contact, and logs the user represented by that social contact into the chat session.
The SocialMiner administrator can add, edit, search, and delete Chat Feeds as well as set the values for the
Chat join and Chat inactivity timeouts. These values are set on a feed by feed basis.
Users can see Chat Feeds on the Configuration tab and can use them (add them to campaigns). Using the
Feed gadget, create a new feed and select the Chat feed type.
VIDEO: View a video [1] about how to set up a Chat Feed.
1. Enter or edit the following fields.
• Type?Required
• Name?Required
• Description
• Chat join timeout-Defines how long the system waits for an agent to join the chat during the setup
process before sending the customer the chatAgentJoinTimeout message (see below).
• Chat inactivity timeout-Defines how long the system waits before automatically closing the chat
session if there is no customer activity.
• Reply template?Select Cisco Chat.
• Optionally, provide Automatic Tags for the feed.
2. Save the Chat Feed.
3. Click the saved Chat Feed from the list of Feeds to open it in Edit mode.
4. Click the Sample Code link to open sample code that contains working HTML with the form fields you
need to make the POST request for the chat feed.
5. Save the code from the Sample Code link locally and modify it as needed.
6. Add the HTML to your website.
• The HTML code from the Sample Code link includes the SocialMiner server IP address and feed ID
(100045 in the following example). If you have multiple chat feeds, the Feed ID will be different for
each one, so be sure to copy the sample code from the correct chat feed.
• The code also contains form fields Title, Author, Description, and Tags and three extension fields.
• In general, extension fields are a collection of custom name/value pairs that can be added to social
contacts and are subsequently displayed in the Agent Chat user interface. The Remarks extension
field appears in the form. The name of the field and the value entered by the customer are added to
the social contact and are displayed to the agent.
• Four hidden extension fields are special extension fields used to customize the Customer Chat user
interface ? they are not added to the social contact and therefore are not displayed in the Agent Chat
user interface.
♦ extensionField_chatAgentJoinTimeOut
Chat Feed
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♦ extensionField_chatError
♦ extensionField_chatLogo
♦ extensionField_chatWaiting
During the chat setup process, if no agent responds before the chat join timeout, the customer is sent a
message (defined in extensionField_chatAgentJoinTimeout) indicating that they can continue waiting or try
again later.
Replace ?./img/ciscoLogoColor.png? with the location of your own logo and replace the default text strings
with the messages you want the customer to see for each circumstance. Note: Users must localize the
messages in the sample form in order for it to appear appropriately in their customer chat interface.
• The sample code also includes a button to Submit.
Here is an example of the SocialMiner code for a Chat Feed. This example is for illustration purposes only do not copy and paste from this example as the server address and Feed ID will not be appropriate for your
instance. Always use the code from the Sample Code link.

<style type='text/css'>span { display: inline-block; width: 100px; }</style>
<meta http-equiv="Content-Type" content="text/html; charset=utf-8">
<form action='https://<SocialMinerServer>/chatproxy/api/chat/form/100045' method='post'>
<span>Title:</span><input type='text' name='title' /><br/>
<span>Author:</span><input type='text' name='author' /><br/>
<span>Description:</span><input type='text' name='description' /><br/>
<span>Tags:</span><input type='text' name='tags' /><br/>
<span>Remarks:</span><input type='text' name='extensionField_remarks' value='sample value' /><
<input type='submit' value='Submit'/>
<input type="hidden" name="extensionField_chatLogo" value="./img/ciscoLogoColor.png">
<input type="hidden" name="extensionField_chatWaiting" value="Welcome, please wait while
we connect you with a customer care representative.">
<input type="hidden" name="extensionField_chatAgentJoinTimeOut" value="All customer care repre
are busy assisting other clients. Please continue to wait or try again later.">
<input type="hidden" name="extensionField_chatError" value="Sorry, the chat service is current
available. Please try again later.">
</form>

Samplechatfeedform.png
When a user completes and submits the form, a URL to the new social contact is returned. The user sees an
interface with the welcome message.
If no agent picks up the chat before the first timeout, the message changes to to indicate no agent is available.
Chat Feed
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If the system reaches the second timeout before an agent picks up the chat, the user receives the chat error
message and a tool tip (displayed when hovering over the information icon) indicates why the chat failed.

Modifying the Sample code for a Chat Feed
You can
• Modify the content within the span tags.
• Add additional Extension Fields.
You cannot delete the title or author.

Example of a Modified Form:
In this modified form, The label for "Title" was changed to "My Issue". The label for "Author" was changed
to "My Name". "Description" was removed. The "Remarks" extension field was removed, and three
extension fields were added: "My Preferred Language", "My Phone", and "My Email".

<style type='text/css'>span { display: inline-block; width: 100px; }</style>
<form action='https://10.86.141.251/chatproxy/api/chat/form/100051' method='post'>
<span>My Issue:</span><input type='text' name='title' /><br/>
<span>My Name:</span><input type='text' name='author' /><br/>
<span>Tags:</span><input type='text' name='tags' /><br/>
<span>My Preferred Language:</span><input type='text' name='extensionField_remarks' value='ent
<span>My Phone:</span><input type='text' name='extensionField_remarks' value='enter phone numb
<span>My Email:</span><input type='text'name='extensionField_remarks'value='enter email addres
<input type='submit' value='Submit'/>
</form>

ModifiedChatFeed.png
Back to Contents

Twitter Account Feed
About the Twitter Account Type Feed
VIDEO: View a video about configuring a Twitter Account Feed. Although this video was created for an
earlier version of SocialMiner and shows an older user interface, it presents accurate information.
Modifying the Sample code for a Chat Feed
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See also SocialMiner Twitter.
The Twitter Account Feed Type uses the Twitter REST API. This Feed type captures Mentions and Direct
Messages for a Twitter account. Twitter Account Feeds include all tweets that include "@USERNAME" and
the Direct Messages to the @USERNAME account. This Feed type also captures tweet type, for example
"retweet" or "in-reply-to". You can have only one Twitter Account for the same user per SocialMiner system.
The Twitter Account feed is configured using OAuth. During the feed configuration, SocialMiner redirects
the user to Twitter to validate the Twitter account. This provides a security benefit, as using OAuth avoids
the storage of the user's Twitter account information on the SocialMiner server. Clicking Save opens the
Twitter authentication service in a new browser window. (You may need to authorize pop-ups in your
browser.) Follow the directions to authorize SocialMiner to access the Twitter account.
If you are signed in to Twitter using the same account you entered in the Feed configuration, click Allow.
If you are not signed in, you are prompted to enter the Twitter Username and Password for the account. It is
also possible that you are logged in to a different Twitter account, such as your personal account. If that is the
case, click sign out, then sign in with the correct account and click Authorize app. After you click Authorize
app, the browser window closes and you return to the Feed Configuration gadget with your new feed
successfully created.
You have now authorized SocialMiner to access all Twitter functionality for this account.
Based on their authorization, Twitter provides SocialMiner with a key to enable access to the account.
SocialMiner will then be able to use the Twitter account. If any issues arise, you can Reauthorize and Save in
Edit Mode.
Twitter provides a list of applications (connections) that have been granted access to a Twitter account. A
Twitter user can revoke access at any time. See http://twitter.com/settings/connections.
Back to Contents
Configuring a Twitter Account Feed
1. Access the Feed Gadget.
2. Click Add.
3. Select the Twitter Account feed type, and enter or following fields:
• Type?Select the Twitter Account feed type from the dropdown. Required
• Name?The name of the feed. Required
• Description
• Username?Required. A valid Twitter username for the user you will be posting as. Note: Only one
Twitter Account Feed per Twitter username per SocialMiner server is allowed.
• Polling Interval?Number of minutes to wait between refreshing this feed. The recommmended
default is 5 minutes.
• Minimum age?The number of hours old a post must be before it is included as a result. This allows
you to exclude recent posts.
• Reply template?The reply template to be used for replying to social contacts obtained from this feed.
Defaults to the Cisco Twitter Reply Template.
• Optionally, provide Automatic Tags for the feed.

Twitter Account Feed
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4. Click Save.
Save redirects you to the Twitter authentication service, which lets you approve using this application with
your Twitter account. Follow the directions to enter credentials to authorize access to the Twitter account.
Reauthorize and Save in Edit Mode
When you edit a Twitter Account feed, there are two buttons: Save and Reauthorize and Save.
If the icon next to a Twitter Account feed is red and the hover text for that icon reports authorization issues,
open the Feed to edit it. Click Reauthorize and Save to initiate the Twitter authorization process.
If there is no indication that you need to reauthorize but you want to edit the feed for other reasons?for
example, to change the Polling Interval?make the change and click Save.

Twitter Rate Limit
Twitter Accounts are rate-limited by Twitter.
When the Twitter rate limit has been reached, the hover text for the feed warning icon shows text similar to
this: "Rate limit reached. Feed will reactivate at 10:39 AM Last successful fetch time was 2 minutes ago,
Success rate is 50%.?.
Note: Polling rates have an impact on how quickly a feed reaches it's limit. A default polling rate of 5
minutes is recommended.
Back to Contents

Twitter Stream Feed
About the Twitter Stream Feed
Important: Only one Twitter Stream per SocialMiner server is supported. Your server IP will be
blacklisted by Twitter if you configure multiple Twitter Stream feeds. If your IP is blacklisted by Twitter,
you must delete all Twitter Stream feeds and wait approximately 2 hours to remove your IP from the Twitter
blacklist.
The SocialMiner Administrator can add, edit, and delete Twitter Stream Feeds. Non-administrators
can only see Twitter Steam Feeds on the Configuration tab and can use them (add them to campaigns).
If you require multiple Twitter Streams, you must discuss this need with Twitter or deploy two SocialMiner
systems. If you have more than one SocialMiner system going through a single proxy, or you are using some
other software system that uses Twitter Streams through that same proxy, your Proxy will be blacklisted by
Twitter.
The Twitter Stream feed type uses the Twitter Stream API or what is sometimes referred to as the "firehose"
interface on Twitter to provide realtime access to Tweets. This interface provides different capabilities than
the Search API. A benefit of this Twitter Stream is the speed and efficiency of capturing greater tweet
volume at faster speeds. There is no polling interval since the interface pushes the Tweets to the SocialMiner
server. The Twitter Stream API also provides more meta-data associated with the tweets then the Search API.
For example, the Twitter Stream API provides the indication that a Tweet is in-reply-to another Tweet (this is
Reauthorize and Save in Edit Mode
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not available via RSS).
There are a couple of downsides to the Twitter stream API. It provides less searching/filtering capability then
the search API. The interface supports keyword searching but, for example, it does not support exclusion of
keywords. This limited searching capability results in more on-board filtering by the SocialMiner server.
Also, the Twitter Stream reply does not provide historical results; therefore downtime in the SocialMiner
system could result in missed Tweets. Finally, due to another limitation in the Twitter Stream API, searches
in languages that are non-space delimited (such as Arabic, Chinese, and Japanese) return no results. More
information on this limitation can be found on the Twitter Developers site.

The Twitter Stream API requires authentication. A Twitter account username and password is required to
configure this type of feed. Note: Twitter only allows one Twitter Stream connection per account. If
there are unrelated Twitter keyword searches required then you must configure multiple Twitter accounts,
since adding unrelated keywords to one stream makes SocialMiner Campaign and Filter configuration
difficult.
When Tweets are captured by SocialMiner using the Twitter Stream, the heading in the social contact
indicates the type of Tweet. For example, the heading indicates if the social contact is a "Tweet" or
"ReTweet" or if it is "in-reply-to". This type of context is not available when capturing Tweets via RSS.
See also SocialMiner Twitter.

Configuring a Twitter Stream Feed Type
VIDEO: View a video about configuring a Twitter Stream Feed. Although this video was created for an
earlier version of SocialMiner and shows an older user interface, it presents accurate information.
1. Access the Feed gadget.
2. Click Add.
3. Select the Twitter Stream feed type, and enter the following fields.
• Type?Required
• Name?Required
• Description
• Search criteria--a comma separated listed of words to search on. Up to 200 keywords can be defined
for a total limit of 2000 bytes. See the table below for examples of what results you will get when entering
different parameters when searching using Twitter Streams.
♦ Each keyword must be between 1-60 bytes.
♦ At least one keyword must be defined.
♦ Commas in the keyword search stand for OR. Spaces in the keyword search stand for AND.
You cannot search for exact strings. For example, if you enter "Cisco Telepresence" then the
social contact returned contains Cisco and Telepresence in them, but not necessarily the
phrase Cisco Telepresence.
♦ Do Not Use a Space after a Comma. If you use a space after a comma then only the first
keyword is matched against.
• Username?Required. A valid Twitter username.
• Password?Required. Password for the Twitter username.
•

Twitter Stream Feed
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• Reply template - The reply template to be used for replying to social contacts obtained from this
feed. Defaults to the Cisco Twitter Reply Template.
• Optionally, provide Automatic Tags for the feed.
4. Click Save to save the feed.
This table provides examples of what results you will get when entering different parameters when searching
using Twitter Streams.
Twitterstream.PNG
Back to Contents

Twitter Search Feed
SocialMiner users can add, edit, and delete Twitter search feeds and use them in campaigns. The Twitter
search feed type allows you to monitor public Twitter time lines for one or more keywords. The Twitter
search API requires authentication, so a valid Twitter account username and password is required to
configure this type of feed.
Configuring a Twitter Search Feed Type
1. Access the Feed gadget.
2. Click Add.
3. Select the Twitter Stream feed type, and enter the following fields.
• Type?Required
• Name?Required
• Description
• Search criteria--Up to 1000 characters are allowed by Twitter to form the search query (including
operators). Twitter may additionally limit queries by complexity.
♦ At least one keyword must be defined.
♦ Spaces in the keyword search stand for AND. Use OR between words to search for phrases
containing one word or the other. Use quotes to search for exact strings (for example, enter
"Cisco Telepresence" to find the phrase Cisco Telepresence).
♦ Note that Twitter search does NOT use commas to delineate search terms like Twitter stream
does. See below for other examples of Twitter searches.
• Username?Required. A valid existing Twitter username.
• Polling interval?Required. The number of minutes to wait between refreshing this feed.
• Reply template - The reply template to be used for replying to social contacts obtained from this
feed. Defaults to the Cisco Twitter Reply Template.
• Optionally, provide Automatic Tags for the feed.
•

4. Click Save to save the feed. When you click Save, the oAuth process starts similar to Twitter Account.

Editing a Twitter Search Feed

Twitter Search Feed
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When you open a Twitter search feed to edit it, there are two buttons: Save and Reauthorize and Save. If
the icon next to a Twitter search feed is red and the hover text for that icon reports 'authorization issues', open
the feed and click Reauthorize and Save to initiate the Twitter authorization process. For all other changes
to the feed, just edit the fields and click Save.

Twitter Search Examples
The API that the Twitter search feed uses is different than the one that Twitter uses for the Twitter stream
feed. Here are some examples of how to find terms using the Twitter search feed.
Enter this...

...to find Tweets

twitter search

containing both words "twitter" and
"search". This is the default operator.

love OR hate

containing either "love" or "hate" (or
both).

beer - root

containing "beer" but not "root".

#haiku

containing the hashtag "haiku".

from: alexiskold

sent from person "alexiskold".

to: techcrunch

sent to person "techcrunch".

@ mashable

referencing person "mashable".

superhero
since:2010-12-27

containing "superhero" and sent since
date "2010-12-27" (year-month-day).

ftw until:2010-12-27

containing "ftw" and sent up to date
"2010-12-27".

movie -scary :)

containing "movie", but not "scary",
and with a positive attitude.

flight :(

containing "flight" and with a negative
attitude.

traffic ?

containing "traffic" and asking a
question.

hilarious filter:links

containing "hilarious" and linking to
URLs.

news
source:twitterfeed

containing "news" and entered via
TwitterFeed.

Polling Interval for Feeds
The polling interval controls how often the SocialMiner system requests the feed. A shorter polling interval
provides more frequent updates but creates more load on the SocialMiner server and on the sites publishing
the feed. Some sites may have recommendations or restrictions on frequent polling and could block an
application that polls too frequently.
The default SocialMiner polling interval for feeds is five minutes. Back to Contents
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Minimum Age for Feeds
Use the minimum age setting to filter out recent posts.
This feature was implemented for forum sites that publish feeds of "unanswered posts." If you configure the
"unanswered posts" feed URL in SocialMiner and set a long Minimum Age, for example 24 hours, the
system only captures posts that are both unanswered (based on the RSS feed) and are older than 24 hours
(based on the Minimum Age). This offers a simple way to implement the business strategy of light touch
forum moderation.
Minimum Age is not applicable for Push Feeds or Twitter Stream Feeds. Back to Contents

Automatic Tags for Feeds
All feeds support the Automatic tags feature, which allows you to specify up to 20 tags that are applied to
new social contacts for a feed across all campaigns that include that feed.
To add an automatic tag to the feed, enter one or more tags into the Automatic Tags text box (separated by
commas), then click Add.
To remove an automatic tag from the feed, click the small x next to the tag name. Back to Contents

Extension Fields in Push and Chat Feed Sample Code
Extension fields are a collection of custom name/value pairs that can be added social contacts using the Push
feed and Chat feed sample code. You can add social contact data to email and IM notifications by including
extension fields as Notification Body Variables.
You can add a maximum of 100 extension fields, up to one megabyte of information.

Deleting Feeds
Select the checkbox to the left of one or more Feed Names and click Delete. A confirmation dialog box
appears. Click OK to confirm deletion of the selected feed(s).
Back to Contents

Campaigns
Topics:
Campaign List
Add and Editing Campaigns
Deleting Campaigns
The Campaigns gadget is on the SocialMiner Configuration tab.
The purpose of a campaign is to group social contacts for handling by the social media customer care team.
Social contacts are included in a campaign when one or more feeds are configured and are selected to be part
Campaigns
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of the campaign. When a feed becomes part of a campaign, new social contacts that arrive on that feed are
immediately added to the campaign and appear on the Home tab. Optionally, campaigns can also have filters,
which are used to narrow or modify the set of social contacts that are added to the campaign.
Social contacts can be discarded, but they are not actually removed from a campaign until they are purged or
the campaign is deleted.
VIDEO: View a video about Campaigns, Campaign usage, and Campaign configuration. Although this video
was created for an earlier version of SocialMiner and shows an older user interface, it presents accurate
information.
Back to Contents

Campaign List
For all SocialMiner campaigns, the Campaign Gadget shows:
• the name of the campaign
• the number of social contacts in the campaign
• a description of the campaign, and
• an RSS feed icon that is a link to the RSS feed from SocialMiner. The RSS feed allows someone to
capture all the social contacts in a campaign using a RSS reader.
This list updates in real time. For example, it updates when another user adds a new campaign to the system,
and the social contact count increments when new social contacts are retrieved for a campaign.
Back to Contents

Adding Campaigns
To add a campaign, click Add in the campaign list view. Fill out the following fields, then click Save to save
the new campaign.
1. Enter a Name (required)
2. Enter a Description (optional)
3. Use the arrows in the Feeds and Filters panels to move one or several feeds and filters between the
Available and Selected panes. You can save a campaign without adding a feed, but no social contacts
will be retrieved for a campaign that has no feeds. Filters are optional.
4. Click Save.
Note: Once you click Save, the social contacts for the configured feeds are added to the campaign. Once
added, social contacts can be discarded but cannot be removed from the campaign except by a purge. If a
feed is removed from a campaign, new social contacts captured by that feed are no longer added to the
campaign, but the social contacts previously included are not removed until the purge.
Note: if a feed is accidentally added to a campaign, and the social contacts must be immediately removed
from that campaign, the only recourse is to delete the entire campaign and recreate it.
Adding a feed to multiple campaigns does not duplicate the social contacts in the datastore. The social
contacts for that feed are simply counted in both campaigns.
Back to Contents
Campaign List
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Deleting Campaigns
To delete a campaign, select the checkbox to the left of one or more campaign names and click Delete. A
confirmation dialog box appears. Click OK to confirm deletion of the selected campaign(s).
Back to Contents

Filters
Topics:
• Filter States
• Types of Filters
• Adding and Editing Filters
• Deleting Filters
A filter modifies and takes action on social contacts as they enter the system and before they appear on the
Home tab, allowing the social media customer-care team to focus on the most actionable social contacts.
Filters are run against social contacts as they enter a campaign. Filters do not run retroactively against social
contacts that are already in a campaign.
You create filters in the Filter gadget on the Configuration tab.
You apply filters to campaigns in the Campaign Gadget by moving them between the Available and Selected
panes, similar to adding and removing feeds. SocialMiner allows a total of 20 filters, and you can add a
maximum of 10 filters to a campaign. Applying multiple filters to a campaign creates opportunities to layer
filtering strategies to fine-tune results.
Note: When multiple filters are applied to a campaign, they are processed simultaneously. For this reason,
you might have unexpected results for social contacts that have been processed by multiple filters.
Back to Contents

Filter States
Icons are used as visual indicators to display the state of each filter. Hover the cursor over the icon to display
a tool tip that explains the state.
• A green icon means the filter is working properly.
• A red icon means an error occurred in the filter. Hover over the error icon to display a tool tip with
the error text.
Note: Cisco Support and the SocialMiner Forum on the Cisco Developer Network do not assist with Groovy
script issues. Direct all troubleshooting requests to your script developer.
• A blue icon appears during a brief interim state while SocialMiner checks the status of the filter, after
which the icon changes to red or green.
Back to Contents
Filters
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Types of Filters
SocialMiner supports three types of filters:
• Bayesian
• Author
• Script

Bayesian Filters
VIDEO: View a video about using Bayesian Filters. Although this video was created for an earlier version of
SocialMiner and shows an older user interface, it presents accurate information.

The Bayesian filter is a trainable filtering technology based on a Bayesian statistical probability model.
Bayesian filters are not pre-programmed or configured with business rules. You must apply a Bayesian filter
to a campaign and then train the filter to recognize the content of "good" social contacts. When training a
Bayesian Filter, you have the option to "train in" or "train out" each social contact in a campaign. After a
sufficient amount of training, the filter begins to exclude unwanted social contacts from a campaign. See
Train Bayesian Filters on the Home Tab.
The Bayesian filters can be used to for many reasons.
• A filter can take a broad keyword search and narrow the results down to the posts related to a
specific brand. For example, a search for "Finesse" could return posts about hair products, Cisco
software, and contract bridge. If the purpose of the campaign is to capture posts about the Cisco
Finesse, the Bayesian Filter can be trained to exclude the social contacts about haircare and bridge.
• A filter can be trained to look for social contacts with negative sentiment (or positive sentiment),
focusing the work of a customer support or marketing team.
• Filters can also be trained to include or exclude social contacts written in specific languages.
The training includes the complete text of the post, not just certain keywords, and therefore offers much more
sophisticated filtering capability then a keyword exclusion approach to filtering.

You can train a Bayesian filter using any campaign. Choose a campaign with some social contacts and open
the Settings page to select the Bayesian filter you want to train. Then Save and close the Setting page. This
puts you in training mode.
The name of the filter you've selected is at the top left of the Home tab, and you see a "+" and "-" button for
each social contact. Click the "+" to "Train In" the social contact, indicating that this is the type of contact
you would like the Filter to keep in the Campaign. Click the "-" to "Train Out" the social contact, indicating
Types of Filters
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that this is the type of contact you would like the filter to reject.
The training does not impact the campaign until you edit the campaign and move the filter from Available to
Selected.
As a best practice, create a test campaign that mirrors an existing "in production" campaign. Add several
feeds to the test campaign - some that you know will have relevant posts and some with irrelevant posts.
Create the filter and set the test campaign to training mode. The more you train the filter, the better the filter
will perform, so it is important to do a significant amount of training before applying your filter to the
"production" campaign.
Back to Contents

Author Filters
View a video about using Author Filters. Although this video was created for an earlier version of
SocialMiner and shows an older user interface, it presents accurate information.

The Author filter allows you to exclude specific social-contact authors. Social contacts posted by an author
identified in an Author filter do not enter a campaign. For example, you may want to filter out your own
posts or posts from team members.
Configuring an Author filter keeps your posts from showing up in your campaign and therefore reduces the
number of posts you need to handle. It also improves the accuracy of the reporting metrics by excluding your
own posts.
Back to Contents

Script Filters
A script filter is custom code that system developers can create in the Groovy Scripting language. A script
filter can apply tags, can change content, and can integrate with external systems to leverage services such as
performing translation or invoking a Klout score for a social contact retrieved from a Twitter Account feed.
You can upload multiple Groovy scripts and attach each to a SocialMiner Script filter. There are examples of
script filters in the SocialMiner Developers Guide and on the Cisco Developer Network (CDN).
The SocialMiner Administrator can add, import, edit, and delete Script Filters. Non-administrators can only
see Script Filters on the Configuration tab and can use them (add them to campaigns).
SocialMiner runs scripts in Groovy 1.8.
Note: During the upload, SocialMiner performs a basic syntactic validation but cannot validate that the script
will work as expected. For this reason, test your scripts on a lab system before using them in production.
SocialMiner also performs security checks on each script. For example, a script does not run if it shuts down
the system, takes longer than 30 seconds to execute, or accesses the SocialMiner file system.
For more on Script Security, see the SocialMiner Developer Guide. Scripts errors are visible when you hover
the cursor over the filter icons on the Filters gadget. You can also open the Runtime Error logs in the Log
Directory to view the list of security breaches. Under the filename "runtime/", open the Error-runtime log and
search for SCRIPT_FILTER_EXCEPTION.

Bayesian Filters
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You will be able to upload scripts that fail the security model and apply them to campaigns, but they will
have no effect on the social contacts. The Filters gadget. will show a red (failure) icon for the insecure script.
Back to Contents

Adding and Editing Filters
To add a Bayesian filter:
1. Click Add.
2. Select Type?Bayesian from the drop-down?Required.
3. Enter a Name?Required. Name must be unique.
4. Enter a Desciption?Some text to describe this filter.
5. Click Save.
To edit a Bayesian filter, click the filter's name.
To add an Author filter:
1. Click Add.
2. Select Type?Author from the drop-down?Required.
3. Enter a Name?Required. It must be unique.
4. Enter a Description?Some text to describe this filter.
5. Authors?Required. Enter an author to exclude from the feed; then click Add, Repeat to add another
author.
6. Click Save.
To edit an Author filter, click the filter's name.
Back to Contents
To add a Script filter:
1. Click Add.
2. Select Type?Script from the drop-down?Required.
3. Enter a Name?Required. It must be unique.
4. Enter a Description?Some text to describe this filter.
5. Click the Browse/Choose File button?Required. Button name varies by browser. Navigate to the
groovy file on your local machine or network. Select it.
6. Click Save.
To edit a Script filter, click the filter's name.
Click the Show Source button to open the groovy script file in a separate window where you can review and
select/copy (but cannot edit) the source. You can also upload a new script file in Edit mode. If you do this,
you can retain or change the Name and Description, as needed.

Script Filters
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Back to Contents

Deleting Filters
Select the check box to the left of one or more Filter Names and click Delete to delete the filter. A
confirmation dialog box opens. Click OK to confirm deletion of the selected filter(s).
Back to Contents

System Administration
Only the SocialMiner Administrator, who is the Application User created during install time, can use this
gadget on the Administration Tab.

The System Administration gadget on the Administration tab provides the following system configuration
and serviceability tools:
• System Status and Statistics
• Active Directory
• Mail Notifications Server
• Proxy Settings
• XMPP Notifications Server
• Purge Settings
• Reporting Configuration
• RTMT Download Links
• Platform Administration
• System Logs

System Status and Statistics
The top section of the gadget has three sections of system status and statistical information:
• Version Information showing the Application Software Version (the version of SocialMiner) and the
Operating System Active and Inactive Software Versions (the version of the Cisco Unified OS).
• Server status for the main services?Datastore, Indexer, Runtime, and Eventing?and for the Hardware
profile (a tool tip shows when you hover over the hardware icon to indicate if the system is a small or
System Administration
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large deployment). If the Mail Notifications Server and the external XMPP Notifications Server
(used for Instant Messaging notifications) are configured, you also see the status of those servers.
• Three graphical meters showing the number of incoming social contacts per hour, the number of
logged-in users, and the disk usage level. The meters help you determine if server is nearing any
limits. If a meter is completely red; consider asking users to log out, modifying your feeds to reduce
the number of incoming social contacts, or increasing your disk allocation. See the CHAT section for
more information on calculating a suitable amount of disk allocation.

Back to Contents

Active Directory
SocialMiner uses Active Directory to manage and administrate user access to the system. All users, with the
exception of the Administration and Reporting users, must be configured on a Microsoft Active Directory
server to be able to access SocialMiner.
The Active Directory connection permits users configured on the AD to access SocialMiner. You can
configure the connection to allow all users on the AD to access SocialMiner, or to allow access to only a
group of users. Multiple, independent groups that require isolated security and permissions should each
deploy their own SocialMiner system.
Note: If Twitter Account feeds are configured on the system, all users are able to see Direct Messages to the
configured Twitter Accounts and all users can post from these accounts. SocialMiner tracks which users
make which posts. Companies that want to restrict who can make posts need to implement that by
configuring SocialMiner to authenticate with a specific role. If SocialMiner is authenticated with a specific
Active Directory role, then only those Active Directory users with that role can use SocialMiner.

To configure Active Directory, open the Administration gadget and click Edit. Enter or modify the following
fields. Click Save when finished.
• Enabled: (checkbox) When checked, the Active Directory connection is active. If not checked, then
only the administrator can log into SocialMiner.
• Host: Required if Enabled is checked. Provide the Host name or IP address and Port of the Active
Directory server.
• Port: Required if Enabled is checked. Provide the port for Active Directory. The default Active
Directory port is 3268. If using SSL the default port is 3269.
• Use SSL: (checkbox). Check to use SSL. You must also exchange security certificates with the AD
server before SSL can work.
• Manager Distinguished Name: Required if Enabled is checked. Enter the Manager Distinguished
Name used to login to the Active Directory server, for example, on a default installation of Microsoft
AD, the name is :CN=Administrator, CN=users, DC=MYSERVER, DC=COM. Replace
MYSERVER and COM with your hostname.
• Manager Password: Required if Enabled is checked. The password for the AD Manager account.
• Role Name: (optional) The Active Directory role or Active Directory group of users who are
allowed to access SocialMiner. If this setting is blank or * then all users in Active Directory are
allowed access to SocialMiner.
Back to Contents
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Exchanging Security Certificates with AD
To enable SSL for the Active Directory connection you must first exchange security certificates between the
two servers. Enabling SSL is optional, but if you do not enable SSL then username and password information
is not transmitted securely between SocialMiner and the Microsoft AD server.
To exchange security certificates, on the Active Directory server:
1. Verify that the Active Directory has the Certificate Services service installed.
2. Select All Programs > Administrative Tools > Certificate Authority.
3. Expand the domain node and select Issued Certificates.
4. Double click the certificate to open it.
5. Open the Details tab and click Copy to file.
6. An Export wizard opens. In the wizard select DER encoded binary.
7. Use the wizard to select a location to save the file.
8. Click Finish.
On the SocialMiner Server:
1. Open the Unified Operating System Administration page. The link is available from the System
Administration gadget (on the Administration tab) under the Platform Administration drawer.
2. Select Security > Certificate Management.
3. Click Upload Certificate.
4. For the Certificate Name, select tomcat-trust.
5. In the Upload File field, select the file to upload by clicking Browse... Select the certificate file you
saved from the Active Directory server.
6. Click Upload File.
7. Restart the Cisco Tomcat service. Using the CLI, run the command utilities service restart Cisco
Tomcat.
Back to Contents

Adding Users
The Administration user (configured at install) and Reporting user accounts are the only accounts explicitly
configured on SocialMiner. The social media customer care representatives are configured in Microsoft
Active Directory. As these users sign into SocialMiner, successfully authenticate against Active Directory,
and begin to take actions on the system, their actions are associated with their Active Directory User ID.
Back to Contents

Mail Notifications Server
Mail Notifications Server settings allow you to configure the SMTP information for a Mail Notifications
Server. You must configure a Mail Notifications server if you intend to use the email notification feature.
To configure the Mail Notifications server, click Edit at the bottom of the Mail Notifications server setting
and edit the following:
• Enabled: Check to enable the Mail Notifications server connection
• Mail Notifications Server Host: Required if Enabled is checked. The IP address or Hostname of the
Mail Notifications Server.
Exchanging Security Certificates with AD
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• Mail Notifications Server Port: Required if Enabled is checked. The port for the Mail Notifications
Server. This is set for port 25 by default. The Mail Notifications server may open port 465 instead for
SSL/TLS connections. For example, the Gmail SMTP server (smtp.gmail.com) uses port 465.
• From Email Address: Required if Enabled is checked. The email address from which emails are sent.
• Use Authentication: Check if the user has SMTP authentication to connect to the Mail Notifications
Server. The following two fields are editable only when Use Authentication is checked.
• User Name: Required if Use Authentication is checked. The user name for signing in.
• Password: Required if Use Authentication is checked. The password for the User Name.
• Use SSL|TLS : Defaults to unchecked. Check this if a secure connection is preferred and is supported
by the Mail Notifications Server. The Mail Notifications Server certificate is not validated for this
release. You must check this if you are using the Gmail SMTP server (smtp.gmail.com).
Click Save to save your changes.
Back to Contents

Proxy Settings

Consult your Network Administrator for the proxy name and port. The same proxy is used across all feeds.
The link for proxy settings is available in the Administration gadget.
To configure the proxy, click the Proxy Configuration link, and edit the following field. Click Save when
finished.
• Enable Proxy (checkbox)?When checked, feeds are accessed through the provided proxy server.
• Hostname?Required when Enable Proxy is checked. The IP address or hostname of the proxy
server.
• Port?Required when Enable Proxy is checked. The port for the proxy server.
• Exclusion Patterns?You can add and remove hostname or IP addresses for servers not requiring a
proxy.
♦ To add an exclusion, type the exclusion into the text box and click Add.
♦ To remove an exclusion, click the red X to the right of the exclusion.
♦ Wildcards are supported, for example *.cisco.com excludes all servers with a cisco.com
hostname and 10.86.* excludes all IP addresses starting with 10.86

Mail Notifications Server
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Click Save to save the settings and return to the Feed gadget page.
Notes:
• Proxy changes may take up to 30 seconds to take effect.
• The exclusion list is limited to 255 total characters. There is an additional character per item in the
list that acts as a separator.
• SocialMiner should only need to access a proxy server if it sits behind a corporate network firewall
and has to use a http/https proxy server for accessing an outside network. You should not need to
give SocialMiner a private NAT address, and doing so is not currently supported.
Back to Contents

XMPP Notifications Server
XMPP Notifications Server settings allow you to configure an XMPP Notifications Server so SocialMiner
can use Instant Messaging (IM) notifications. You must configure an XMPP Notifications Server if you
intend to use the IM notification feature.
To configure the XMPP Notifications Server, click Edit at the bottom of the XMPP Notifications Server
setting and edit the following:
• Enabled: Check to enable the XMPP Notifications Server connection
• XMPP Service Lookup: Check to enable XMPP Service Lookup. When enabled, the User Name's
domain is used to connect to the correct XMPP Notifications Server.
• XMPP Notifications Server Host: The IP address or Hostname of the XMPP Notifications Server.
This does not apply if XMPP Service Lookup is checked.
• XMPP Notifications Server Port: The port for the XMPP Notifications Server. This is set for port
5222 by default. This does not apply if XMPP Service Lookup is checked.
• User Name: The user name (in full JID format, such as user@domain.name), which is used to sign in
to the XMPP Notifications Server.
• Password: The password for the above User Name. NOTE: If you change your XMPP password for
any reason?intentionally or to comply with network policy?change it here.
Click Save to save your changes.
Note: A small lock icon appears in the bottom left of the agent chat interface and in the bottom right of the
campaign results interface to indicate the status of the XMPP connection. The lock is greyed out of there is
no connection.
Back to Contents

Purge Settings
Database purges are required to remove old data from the datastore so that the disk does not fill up. Datastore
purges occur on a continuous basis (every hour) based on the age of the social contacts and disk usage.
Important! Purge settings take effect as soon as you click Save. If any of the criteria are met, such as
Emergency purge when disk usage exceeds (%), the purge starts immediately.
To configure purge settings, click Edit at the bottom of the purge settings tool and edit the following:

Proxy Settings
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DataStore Purge Settings:
• Purge Social Contacts older than (days): Social contacts older than this number of days are purged.
Values must be integers (no decimals).
Important!: SocialMiner will not retrieve social contacts older than this setting.
• Emergency purge when disk usage exceeds (%): Begin an emergency purge if disk usage exceeds
this value. Valid values are 60 - 90. When an emergency purge executes, social contacts older than
the number of days specified above are removed. If disk usage is still above the setting for this field,
the purge continues removing social contacts (one day at a time) until the disk usage is below the
threshold for emergency purge.
Back to Contents
Reporting Purge Settings:
• Purge start time (HH:mm 24 hour format): The time, in 24 hour format (00:00 to 23:59), that the
purge starts based on the local server time. By default this is set to 01:00 (1am) local server time.
• Purge Social Contacts older than (days): Reporting records for social contacts older than this number
of days are purged when the reporting purge starts.
Click Save to save your changes.
Back to Contents

Reporting Configuration
Reporting configuration allows you to set or change the Informix password for the reporting user. You
cannot change the reporting user's username. It is set to "reportinguser".
The reporting user is used by Cisco Unified Intelligence Center (CUIC) and third-party applications to access
the reporting database. Details on the tables in the reporting database are available in the SocialMiner
Developer Guide.
To set or change the password for the reporting user, enter a new password in each of the password fields and
click Save.
This section also displays the Reporting Server and Database information. This information is required for
third-party connection to the database. The details include:
• Reporting Host?The hostname to use when connecting to the reporting database.
• Reporting Port?The port for the reporting database server.
• Reporting Server?The Informix server name for the reporting database. When configuring CUIC,
this is the "Instance".
• Reporting Database?The Informix database name for reporting.
• Database Type ?The type of database (Informix).
• Username?The reporting username is fixed at "reportinguser" and cannot be changed.
• Password/Re-enter New Password?The password for the reporting user.
When configuring CUIC, you must select UTF-8 as the character set.
Back to Contents

Purge Settings

43

SocialMiner_Release_9.0(1)

RTMT Download Links
Links are provided to download the Unified Real Time Monitoring Tool (RTMT). SocialMiner uses the same
RTMT as the one used for Unified Communications Manager.
Details on Installing and Configuring RTMT can be found on the Cisco web site: Installing and Configuring
Cisco Unified RTMT
Back to Contents

Platform Administration
Platform Administration provides links to the following interfaces of Cisco Unified OS:
• Cisco Unified Operating System Administration?Use tools on this interface to upgrade software and
to import certificates.
• Cisco Unified Serviceability
• Disaster Recovery System?Use tools on this interface to back up and restore.
SocialMiner uses the same platform administration tools as Unified Communications Manager. Online help
is available in the tools.

Back to Contents

System Logs
The System Logs tool provides links to access the Log Directory of SocialMiner or to perform a System
Health Snapshot.
Important! Do not click the System Health Snapshot link unless directed to by Cisco TAC. Accessing this
link forces the system to stream all system parameters into a large XML file for download. System
performance is impacted while the snapshot is occurring.
Back to Contents

Notifications
Only the SocialMiner Administrator, who is the Application User created during install time, can use this
gadget on the Administration Tab.
VIDEO: View a video about configuring instant message notifications. View a video about configuring
email notifications. Although this video was created for an earlier version of SocialMiner and shows an older
user interface, it presents accurate information.
The Notification gadget on the Administration Tab lets you view, delete, edit, and add notification rules. Set
up notification rules to send messages in reference to tagged social contacts.
If a reply template is associated with the social contact for which the notification is sent, the person who
clicks the link in the IM or email opens SocialMiner to that reply template.

Notifications
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You can also send notifications to a mobile phone using an SMS Gateway service. Here is a list of SMS
Gateways by carrier.
Notes:
Establishing a notification rule for email requires that the administrator has configured a Mail Notifications
Server in the System Administration gadget.
Establishing a notification rule for IM requires that the administrator has configured an XMPP Notifications
Server in the System Administration gadget.
Notifications are triggered by tags. For email and IM, you have set up tags for social contacts. See Tagging
Social Contacts on the Home tab and Automatic Tags.
IM and email notifications do not accept replies. The intent is to notify, not to open a dialog.
Auto-tagging or adding multiple tags at the same time (in one operation) generates multiple notifications to
the same recipients list.

Using the Notification Gadget you can
• Delete a notification by checking the box next to the notification name and clicking Delete.
• Edit a notification by clicking the notification's name.
• Add a notification by clicking Add.
To configure a notification, provide or edit the following fields in the Notification gadget.
1. Type?Required. The type of notification. Notifications can be:
1. Email?Notification is sent over email - A Mail Server must be configured in the System
Administration gadget to send Email notifications.
2. IM?Notification is sent over IM - An XMPP Notifications Server must be configured in the
System Administration gadget to send IM notifications.
3. HTTP?Reserved for developer applications that deliver social contact data to an external
application.
2. Name?Required. The name of the notification.
3. Description?A brief description of the notification.
4. Campaign?Required. Select a campaign to which you are associating this notification.
5. Tag?Required. Enter a tag for this notification and click Add. Repeat for each tag. Notifications are
sent when a social contact is tagged with this tag and exists in the Campaign above. To remove a tag,
click the x at the right of the field.
6. Addresses?Enter an address and click Add to add an address to this notification. Repeat for multiple
addresses. Addresses must be in the format user@domain.com. Used only for Email and IM
Notifications, for which it is Required. To remove an address, click the x at the right of the field.
7. Subject?The email subject for this notification. This field is only available for Email notifications.
Subject is optional and is blank by default. As a best practice, enter a subject for email notifications.
8. Body?The body for this notification. HTML tags are supported for Email Notifications. IM
notifications are sent using plain text. The body of the message supports variables so you can
customize the information sent in the notification. See "Notification Body Variables" below.
Back to Contents
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Notification Body Variables
The notification body for emails and instant messages can contain keywords in the syntax ${KEYWORD}.
These keywords will be replaced with values from the Social Contact. Keywords are listed here in uppercase,
but they are case-insensitive.
By default, the body of the message contains the URL of the social contact?the ${SC_SCREEN_URL}. You
can add the following variables to the body of the notification to include the value of the variable in the
notification. For Email Notifications, you can also use HTML tags to stylize the notification. IM notifications
are sent using plain text.
• ${SC_AUTHOR}?the Social Contact Author (not available in all feeds)
• ${SC_CREATED_DATE}?Date the Social Contact was created in the system.
• ${SC_DESCRIPTION}?The description of the social contact. Typically this is the tweet, RSS post,
facebook fan page post, etc.
• ${SC_PUBLISHED_DATE}?The publish date of the social contact (not available in all feeds)
• ${SC_SCREEN_URL}?The URL to the social contact in the results gadget. Clicking this URL
allows you to instantly reserve/reply to the social contact.
• ${SC_SOURCE_TYPE}?The feed type of the social contact, for example; RSS, Twitter Stream,
Twitter Account, FaceBook
• ${SC_TAGS}?The tags for this social contact.
• ${SC_TITLE}?The title of the social contact.
• ${SC_EXTENSION_FIELDS.<fieldname>}?This variable adds a specific, named extension field
for the social contact. You can add a maximum of 100 extension fields, up to one megabyte of
information.
• ${SC_EXTENSION_FIELDS}?This variable adds all extension fields that exist for the social
contact. They appear in the body in alphabetical order by name, in the format Name: Value. If no
value was defined, you see Name: (?). If there are no extension fields, the variable is removed from
the message body.
If the body an email notification includes:
The author of this Social Contact is: <strong>${SC_AUTHOR}</strong> <br />
The message contents are as follows: <strong>${SC_DESCRIPTION}</strong> <br />
You can Reserve/Reply to the Social Contact <a href="${SC_SCREEN_URL}">here</a>.
The actual email notification sent appears as
The author of this Social Contact is: Joe Somebody
The message contents are as follows: This is a TWEET!
You can Reserve/Reply to the Social Contact here.
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Reply Templates
Only the SocialMiner Administrator, who is the Application User created during install time, can use this
gadget on the Administration Tab.
The SocialMiner Reply Templates gadget on the Administration Tab lists available Reply Templates. The
gadget displays the three installed system-provided templates and lets you configure custom reply templates
to be used with the system.
Reply Templates
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System Templates: The three system-defined templates cannot be edited or deleted. They are
• Cisco Twitter?Used for Twitter Account and Twitter Stream feeds only, for which it is the default
option. This template opens when you reply to a tweet on the Home tab. Before you send your reply,
you have the option to save your response and have it reviewed.
• Cisco Facebook?Used for Facebook Fan Page feeds only, for which it is the default option. This
template opens when you reply to a Facebook Fan Page on the Home tab. Before you send your
reply, you have the option to save your response and have it reviewed.
• Cisco Chat?Used for Chat Feeds only, for which it is the default option. This template opens the chat
room for the agent and displays a connection message to the customer.
Custom Templates: An administrator can develop custom reply templates and use them for RSS, Twitter, or
Facebook feeds. Until you create a custom template, No reply template is the only reply template option for a
Push or RSS feed.
To add a custom template:
1. Click Add.
2. Enter a name (Required).
3. Enter the URL for the location of the custom template code (Required).
An example of code for a reply template is provided on the system at
http://<servername>/templates/reply/custom_reply_sample.jsp

The source code is commented and provides details on the SocialMiner javascript functions required.
See also the Custom Reply training lab.
To delete a custom template:
1. Select it.
2. Click Delete.
3. Confirm the deletion.
Reply templates must conform to the OpenSocial gadget standard. Some tips for converting existing HTML
pages into OpenSocial gadgets can be found here.
After you have created your Reply Template, host it on a webserver that is accessible by SocialMiner, and
use the Reply Template gadget to provide a name for the Reply Template and its location.
Back to Contents

Customer Chat
• Chat Process
• Chat Behavior
• Chat Errors

SocialMiner supports a maximum of 120 (in a small deployment) and 400 (in a large deployment)
Customer Chat
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simultaneous single-session chats between a customer and an agent. The customer is an individual who
submits the chat form on your website. The agent is an individual who uses SocialMiner to respond to social
contacts in a campaign that is set up with a chat feed.
For a chat to occur, there must be at least one SocialMiner Chat Feed, and the feed must be added to a
campaign.

Chat Process
This is the flow of the chat process.
The SocialMiner Administrator:
• Creates and saves a Chat Feed in SocialMiner, using the Cisco Chat reply template
• Adds the Chat Feed to a campaign
• Copies the Chat Feed sample code and pastes it in a text editor
• Makes changes to the code, if needed
• Saves the code as HTML
• Publishes the HTML to a website
The customer:
• Selects a Click-to-Chat (or similar) link or button on the website to open the chat feed form
• Completes the form and submits it
The customer sees a welcome message asking them to wait while they are connected to a customer care
representative.
If no agent responds before a defined timeout, the customer is sent a message indicating that they can
continue waiting or try again later. If an error occurs during setup, the customer is sent a message indicating
that chat is not available and to try again later.

SocialMiner:
• Sets up a chat session and creates a social contact in SocialMiner with the form data, the URL of the
chat session, and the URL of the chat reply template that serves as the chat gadget interface
• Generates a chat, which appears in the chat campaign
The agent:
The agent clicks the Reply icon for the social contact to enter the chat session and to display the Agent Chat
Reply template (similar to the example shown here). Information about the customer is displayed on the left
side of the screen. The agent can increase or decrease the size of the font in the chat window using the font
sizing buttons or with keystroke combinations ctrl+shift+] for increase and ctrl+shift+[ for decrease.

Chat Process
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A customer chat interface opens when an agent joins. The Chat interface supports accessibility by using the
JAWS ?highlighted text? functionality. With JAWS configured to read highlighed text and Accessibility
mode enabled, incoming chat messages and other events are highlighted briefly so JAWS can announce
them. Customers enable Accessibility mode using keystroke combination ctrl+shift+S.
Customers can increase or decrease the size of the font in the chat window using the font sizing buttons or
with keystroke combinations ctrl+shift+] for increase and ctrl+shift+[ for decrease.

The conversation between the agent and customer begins and the social contact state changes to Reserved.
After the conversation is complete, the customer can leave the chat by closing their browser window or by
navigating to another url from the chat window browser. (If a customer refreshes the chat window browser,
the chat session will end just like navigating away or closing the browser.)
The agent can close the chat window by clicking the End button or using the keystroke combination
ctrl+shift+E.
Back to Contents
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Chat Behavior
In the Chat session interface:
• Each party types a message and presses Enter. The agent receives the customer's message
immediately. The customer receives the agent's response within five seconds, based on the timing of
the response in relation to the five-second polling interval.
• The agent sees a time marker next to each customer entry.
• URLs and email addresses are actionable links.
• When the agent ends the chat; the chat session is removed, the customer receives an end of
conversation message, and the social contact state changes to Handled.
• Once chat starts, there is no timeout for the agent but there is user-defined customer inactivity
timeout. A customer who does not send a message for five minutes is removed from the chat session.
• Agents who navigate away from a chat - for example, to consult a web page - can reconnect as
follows: select Reply to change the social contact state back to Unreserved, select Reply again to
reserve the social contact, and rejoin the chat.
• After a chat ends, agents can search for the chat session transcript using the interface on the Search
tab.
Back to Contents

Chat Errors
If the server goes down, or if cookies are cleared on the customer side, the customer sees a "Connecting to
server..." message, followed by an "Error connecting to server" message.
See Provisioning for information on system limitations for chat that, if exceeded, may also cause chat errors.

SocialMiner Reporting
SocialMiner maintains metrics on social contact volume and agent activities. These metrics are stored in a
SQL database for up to 18 months. The reporting database can be accessed using any SQL reporting tool
including CUIC. Access to this database requires configuration of a reporting user in the SocialMiner system
administration.
There are two main categories of reports:
• Campaign Reports - These metrics provide an indication of the total posting volume by customers as
well as the responsiveness to customers. These are what could be described as "customer facing"
metrics.
• Agent Reports - These metrics provide an indication of the agent productivity. These metrics could
be used to evaluate agent speed or they could be used to measure total workload as a basis for
staffing forecasts.
The CUIC templates for SocialMiner are available for download here:
http://www.cisco.com/cisco/software/release.html?mdfid=283613136&catid=278875240&softwareid=283733464
Note: For CUIC releases prior to 8.0(3), you must extract the templates from the zip file before importing
them into CUIC. For release 8.0(3) and later, you can import the zip file directly and CUIC extracts all the
templates it finds inside the zip file.
The following screen captures are examples of the CUIC Reports daily reports:
SocialMiner Reporting
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• ASR - Average Speed of Reserved. For the social contacts that were Reserved, this is the average
time between capture by SocialMiner and the time they are marked as reserved. This provides an
indication of how much time passes before someone first views the customer's post.
• ASA - Average Speed of Answer. For the social contacts that were Handled, this is the average time
between capture by SocialMiner and the time they are marked handled. This provides an indication
of how of how much time passes before the customer gets a response.
• ASD - Average Speed of Discard. For the social contacts that were Discarded, this is the average
time between capture by SocialMiner and the they are marked discarded. This provides an indication
of how much time passes before someone chooses to discard the customer's post. Note: "Discard"
doesn't necessarily mean the post is disregarded. The distinction between "Discard" and "Handled"
depends on how the agents are using SocialMiner. For example, they might mark posts that are read
as "discarded" and posts that are responded too as "handled". In this case, discarded means that they
were "read".

SocialMiner Reporting
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The complete SocialMiner reporting database schema is documented in the SocialMiner Developer Guide

• AHT - Average Handle Time. For social contacts that were handled by this agent, this is the average
time between Reserved and Handled. This provides and indication of how much time it takes this
agent to respond to a social contact.
• ADT - Average Discarded Time. For social contacts that were discarded by this agent, this is the
average time between Reserved and Discarded. This provides an indication of how much time it
takes this agent to discard a social contact.
• ACT - Average Completed Time. For social contacts that were Handled or Discarded, this is the
average time between capture by SocialMiner and the first time they were marked Handled or
Discarded. This provides an indication of how of how much time it takes for this agent to complete
work for a social contact.
Back to Contents
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Configuring the SQL Connection to the SocialMiner Reporting
Database
Connection to the SocialMiner Informix reporting database can be made through JDBC using the following
format:

jdbc:informix-sqli://<hostname>:<port>/<databasename>:INFORMIXSERVER=<informixserv
• The reporting database <port> is 1526.
• The <databasename> is "mmca_data".
• The <informixserver> name is based on the hostname of the server with _mmca append to the end of
the hostname. Additional, any dashes ("-") in the hostname are replaced by underscores ("_").
• The UTF-8 Charset is required to get CUIC able to connect.
• The content of INFORMIXSERVER is the instance name. It must be lowercase.
• The database host can be socialminer with all lowercase and the instances must also be lowercase.
For example, if your server's hostname is my-server.mycompany.com, then the INFORMIXSERVER name
is my_server_mmca. The complete JDBC URL is:

jdbc:informix-sqli://my-server.mycompany.com:1526/mmca_data:INFORMIXSERVER=my_serv
When authenticating, the informix username is always reportinguser and the informix password is the
password you created in the Administration Gadget.
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Downloading and Installing Language Packs
Download and install language packs only if you require the SocialMiner interface in a language other than
English.
A downloadable zip file of internationalized SocialMiner user interface and online help files is available on
cisco.com.
The filename is of the format "SocialMiner-languagePack-x.x.x.zip.
Downloading and unzipping the file gives you 18 language packs with the file extension of "##.cop.sgn". The
zip file also contains a Readme.txt with instructions on installing COP files.
The authorization process for File Download has changed. You may need to access OnRamp to request
Software Download Access. (New Account Request -> Request For Myself -> Customer Advocacy ->
Software Download and Special File Publishing Access -> Software Download Access)
IMPORTANT: Do not change the name of the files.
Language

LanguagePack example filename

Chinese
(Simplified)

ccp-language-zh_CN-8.5.3.1000-1.cop.sgn

Chinese
(Traditional)

ccp-language-zh_TW-8.5.3.1000-1.cop.sgn

Downloading and Installing Language Packs
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Danish

ccp-language-da_DK-8.5.3.1000-1.cop.sgn

Dutch

ccp-language-nl_NL-8.5.3.1000-1.cop.sgn

Finnish (France) ccp-language-fi_FI-8.5.3.1000-1.cop.sgn
French (France)

ccp-language-fr_FR-8.5.3.1000-1.cop.sgn

French
(Canadian)

ccp-language-frCAFR-8.5.3.1000-1.cop.sgn

German

ccp-language-de_DE-8.5.3.1000-1.cop.sgn

Italian

ccp-language-it_IT-8.5.3.1000-1.cop.sgn

Japanese

ccp-language-ja_JP-8.5.3.1000-1.cop.sgn

Korean

ccp-language-ko_KR-8.5.3.1000-1.cop.sgn

Norwegian

ccp-language-nb_NO-8.5.3.1000-1.cop.sgn

Polish

ccp-language-pl_PL-8.5.3.1000-1.cop.sgn

Portuguese
(Brazil)

ccp-language-pt_BR-8.5.3.1000-1.cop.sgn

Russian

ccp-language-ru_RU-8.5.3.1000-1.cop.sgn

Spanish

ccp-language-es_ES-8.5.3.1000-1.cop.sgn

Swedish

ccp-language-sv_SE-8.5.3.1000-1.cop.sgn

Turkish
ccp-language-tr_TR-8.5.3.1000-1.cop.sgn
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System Backup and Restore
SocialMiner supports the Unified OS Disaster Recovery System (DRS) to perform backup and restore of the
system. You access the Disaster Recovery System by going to the Administration Gadget, expanding the
section on Platform Administration, and then selecting the link for Disaster Recovery System.
SocialMiner uses the same platform administration tools as Unified Communications Manager. Online help
is available in the tools.
You can manually back up your system using DRS, or schedule DRS to perform automatic backups.
Details on using DRS are available in the DRS online help and in this guide:
http://www.cisco.com/en/US/docs/voice_ip_comm/cucm/drs/8_0_1/drsag801.html.

Quick Manual Backup Instructions
These instructions provide quick instructions to create a manual backup. You can also schedule backups to
run automatically. The system is not usable during a backup and new social contacts are not collected during
a backup. Schedule your backups accordingly.
The online help for the Disaster Recovery System provides complete details on all features of DRS.
However, using DRS with SocialMiner is greatly simplified because SocialMiner supports only a single node
and only uses network backups.
To perform a manual backup:

System Backup and Restore
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Define Backup Device
1. Access the Disaster Recovery System by going to the Administration Gadget, expanding the section
on Platform Administration, then selecting the link for Cisco Disaster Recovery System.
2. Select Backup > Backup Device.
3. On the Backup Device List page, select Add New.
4. Provide a Device Name for the backup device. SocialMiner only supports backing up to a Network
Directory, provide the Network Directory details for a server that supports SFTP.
5. Provide the Number of backups to store on the Network Directory value. The default is two, so only
the two latest backups are preserved.
6. Click Save, the system verifies the information you entered and saves the backup device.
The backup device is now saved. You do not need to repeat these steps the next time you back up the system
unless you want to back up to a different device or change backup device settings.

Backup the System to the Backup Device
1. Access the Disaster Recovery System by going to the Administration Gadget, expanding the section
on Platform Administration, and then selecting the link for Disaster Recovery System. Log in
using the platform credentials you supplied when you installed SocialMiner.
2. Select Backup > Manual Backup.
3. Select the Backup Device you created earlier from the pull down menu in Select Backup Device.
4. In Selected Features check SOCIALMINER.
5. Click Start Backup.
6. A warning appears indicating that you may need to use the security password to restore. Click OK.
The backup begins.
7. The backup page refreshes periodically providing the status of the backup. The page also displays the
name of the backup tar file that is being saved to the remote system.
8. After the backup completes, wait a few minutes before using SocialMiner so the SocialMiner system
can restart subsystems shutdown during the backup.

Restoring from a Backup File
1. Access the Disaster Recovery System by going to the Administration Gadget, expanding the section
on Platform Administration, and then selecting the link for Disaster Recovery System. Log in
using the platform credentials you supplied when you installed SocialMiner.
2. Select Restore > Restore Wizard.
3. Select the backup device from the drop-down menu and select Next.
4. Select the backup file you want to restore for the Tar file list drop-down menu and select Next.
5. Check SocialMiner in the Select Features section and select Next.
6. Read the warning on the page. Optionally select File Integrity Check, then select the Server to be
restored (typically the host name of the backed up system). Click Restore.
7. The restore page refreshes periodically providing the status of the restore.
8. After the restore finished, restart SocialMiner.
Back to Contents

Design Guidance
Topics:
• Advanced UI Options
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• Command Line Interface
• Supported Commands and User Interface Options
• Deployment Models
• Hardware and Software Specifications
• Ports
• Obtaining a CA-Signed Certificate
• Avoiding certificate warning
• Avoiding Login Overlays if Reply Template Container Loads in IFRAME in IE
• Provisioning
• SocialMiner User Accounts and Security
• Twitter Accounts and Security
• VMware Open Virtual Format (OVF)

Advanced UI Options
The SocialMiner user interfaces are designed to be embedded in other web application user interfaces.
If your web site or application doesn't support OpenSocial, then add SocialMiner to a web page by using an
iFrame (for example). With this technique you can make a frame sized to show one of the SocialMiner web
pages (like the campaign results gadget).
Back to Contents

Command Line Interface
To access the CLI for SocialMiner:
• SSH to the address for your SocialMiner server.
• Sign in with your administrator credentials.
• Type a ? at the admin: prompt to see the list of commands.
See Cisco Systems CLI documentation.
Most CLI commands do not apply to, or have not been certified for SocialMiner.
Back to Contents

Supported Commands and User Interface Options
The following tables describe the VOS Command Line Interface (CLI) commands and the Cisco Unified
Operating System Administration and Disaster Recovery System user interface options that SocialMiner
supports.
Only the commands/options explicitly mentioned as supported below are supported by SocialMiner. Any
commands or options not listed are not supported.
However, in select instances, users may be instructed to use commands that are not normally supported (such
as in a field notice).

Advanced UI Options
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Note: Although this guide provides instructions for accessing SocialMiner CLI admin commands, most of
the CLI commands do not apply to, or have not been certified for SocialMiner.

Command Line Interface
This table specifies the VOS CLI commands that are supported, and indicates certain ones that are not.
Command

Supported?

delete

No

file

No

help

Yes

quit

Yes

run

No

set date

Yes

set timezone

Yes

All other set commands

No

show

Yes

unset

No

utils csa disable

Yes

utils network ping

Yes

utils reset_ui_administrator_name

Yes

utils reset_ui_administrator_password

Yes

utils service list

Yes

utils service restart

Yes

utils service start

Yes

utils system restart

Yes

utils system stop

Yes

utils system shutdown

Yes

utils system switch-version

Yes

utils system upgrade

Yes

All other utils commands

No

Cisco Unified Operating System Administration User Interface
This table specifies the Administration user interface commands and options that are supported, and indicates
certain ones that are not.
Command

Supported?

show

Yes

Settings > NTP Servers

Yes

Settings > Time

Yes

All other Settings menu options

No

Security > Certificate Management

Yes

All other Security menu options

No

Supported Commands and User Interface Options
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Software Upgrades > Install/Upgrade

Yes

All other Software Upgrades menu options

No

Services > Ping

Yes

All other Services menu options

No

Help

Yes

Disaster Recovery System User Interface
This table specifies the disaster recovery system commands and options that are supported, and indicates
certain ones that are not.
Command

Supported?

Backup > Backup Device

Yes

Backup > Manual Backup

Yes

Backup > History

Yes

Backup > Current Status

Yes

Backup > Scheduler

Yes

Restore

Yes

Help
Back to Contents

Yes

Deployment Models
Version 9.0 of SocialMiner has a single-server, all-in-one, small or large deployment model. You cannot use
a load-balancing split data-center deployment. There is no replication. The solution is not redundant. The
best availability solution for SocialMiner is to back it up at a second location using a scheduled backup. In
the event of a site loss, you then restore into a new VM.
The server may be deployed inside or outside the corporate firewall in "Intranet" and "Internet" deployment
models.
• The Intranet deployment model provides the additional security of the corporate network firewalls to
reduce risk of an external party accessing the system. This deployment model is required if
SocialMiner must access internal sites, such as an internal forum site. The downside of the Intranet
deployment model is that SocialMiner system cannot be accessed by partners lacking VPN access. It
is common for some public relation functions to be externally managed by an agency and offering
easy access (no VPN) to the SocialMiner system is very useful. Also, the Intranet deployment model
does not allow rendering of SocialMiner OpenSocial Gadgets in public Internet containers such as
iGoogle. The Intranet deployment model complicates proxy configuration, however it simplifies
directory integration.
• The Internet deployment model puts SocialMiner outside the corporate firewall. This deployment
model relies on the built-in security capabilities of the SocialMiner appliance. This is acceptable
from a security perspective depending on the system use and corporate policies. For example, in
some applications the SocialMiner system handles 100 percent public postings and there is no
disclosure risk associated with a compromised SocialMiner system. The Internet deployment model
may complicate directory integration.
SocialMiner can be deployed where some users access the server through a firewall or proxy. For the
customer chat interface, the SocialMiner server can be deplyoyed behind a proxy server or firewall to prevent
Cisco Unified Operating System Administration User Interface
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it from being abused or limiting access for those outside the firewall.
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Hardware and Software Specifications
Cisco supports SocialMiner deployment on any hardware provided SocialMiner is installed within the Cisco
provided VMWare OVF.
Possible server options include Cisco UCS servers such as:
UCS Model

SKU

C210-M2

UCS-C210M2-VCD2

B200-M2

UCS-B200M2-VCS1

Back to Contents

Ports
Port 25 is the default port for email.
Port 465 is used by the mail server for SSL/TLS connections.
Port 443 is used for a secure connection between the SocialMiner user interface and your browser.
Port 80 is used by SocialMiner for unsecure communication with Twitter and Facebook APIs.
Port 7071 is used for unsecure BOSH connections to the XMPP/Eventing server.
Port 7443 is used for secure BOSH connections to the XMPP/Eventing server.
Your firewall configuration may need to be modified to open these ports for SocialMiner.
Back to Contents

Obtaining a CA-Signed Certificate
Each time you sign-in, you must obtain an application and root certificate signed by a Certificate Authority
(CA) to eliminate browser security warnings.
Use the Certificate Management utility from Unified Operating System Administration.
Open Unified Operating System Administration from the Administration tab > Platform Administration.
You can also use the URL
http://<servername>/cmplatform

where servername is the Name or IP address of the server. Sign in with your Administrator credentials.

To obtain the certificates:
Deployment Models

59

SocialMiner_Release_9.0(1)
1. Select Security > Certificate Management > Generate CSR.
2. After the successful generation, click Download CSR.
3. Use the CSR to obtain the signed application certificate and the CA root certificate from the CA.
To upload the certificates:
1. When you receive the certificates, open Unified Operating System Administration from the
Administration tab > Platform Administration.
2. Select Security > Certificate Management > Upload Certificate.
3. Select the certificate name from the Certificate Name list.
4. Upload the root certificate.
1. In the Upload dialog box, select TomCat Trust from the dropdown.
2. Browse to the file and click Open.
3. Click Upload File.
5. Upload the application certificate.
1. In the Upload dialog box, select TomCat from the dropdown.
2. Enter the full name (including the file extension) of the CA root in the Root Certificate text
box.
3. Browse to the file and click Open.
4. Click Upload File.
See the Security topics in the Unified CM Operating System Administration online help.
After you upload the certificates:
1. Sign out of SocialMiner.
2. Restart the XMPP Service. (SSH to SocialMiner and use this CLI: admin:utils service restart
SocialMiner XMPP Server).
3. Restart Tomcat. (SSH to SocialMiner and use this CLI: admin:utils service restart Cisco Tomcat).
4. Sign in to SocialMiner.
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Avoiding certificate warning
To avoid the certificate warning message. make sure your DNS server is properly configured and you can
resolve the fully qualified SocialMiner hostname to the SocialMiner IP address.
• If a DNS server is not present, then add an entry in your hosts file (in Windows, the path to the hosts
file is %SystemRoot%\System32\drivers\etc\hosts).
Use the fully qualified hostname in the browser to access the SocialMiner server. (Do not use the IP address
because it will not match the hostname in the certificate.)
Use a signed certificate from a trusted certificate authority (like Verisign).
• If you use a self-signed certificate (which is what is installed with SocialMiner), then follow the
procedures below to avoid warnings in IE8 on Windows. Firefox launches a wizard to import
certificates.

Obtaining a CA-Signed Certificate
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Download the certificate file.
• Open https://<SocialMiner Hostname> in IE8.
• If the certificate is not already imported, you see website's certificate warning page.
• Click on Continue to this website.
• You see a certificate error next to the address bar.
• Click on the certificate error and then click on View certificates. This opens a certificate dialog.
• On the Details tab, click Copy to a file.
• This launches the certificate export wizard. Keep all of the default settings and click Next.
• Specify a filename in "File to export" and finish the wizard.
• The certificate is now in the exported file.
Add certificates to the Trusted Root Certification Authorities store for a local computer.
• ?Administrators? is the minimum group membership required to complete this procedure.
• Click Start, then click Start Search. Type "mmc" and press Enter.
• On the File menu, click Add/Remove Snap-in.
• Under Available snap-ins, click Certificates, then click Add.
• Under This snap-in will always manage certificates for, click Computer account, then click Next.
• Click Local computer and then click Finish.
• If you have no more snap-ins to add to the console, click OK.
• In the console tree, double-click Certificates.
• Right-click the Trusted Root Certification Authorities store.
• Click Import to import the certificates and follow the steps in the Certificate Import Wizard.
Add certificates to the Trusted Root Certification Authorities store for a domain.
• ?Domain Admins? is the minimum group membership required to complete this procedure.
• Open Server Manager and under Features Summary, click Add Features. Select the Group Policy
Management check box, click Next, then click Install.
• After the Installation Results page shows that the installation of the GPMC was successful, click
Close.
• Click Start, point to Administrative Tools, and click Group Policy Management.
• In the console tree, double-click Group Policy Objects in the forest and domain containing the
Default Domain Policy GPO that you want to edit.
• Right-click the Default Domain Policy GPO, and click Edit.
• In the GPMC, go to Computer Configuration, Windows Settings, Security Settings and click Public
Key Policies.
• Right-click the Trusted Root Certification Authorities store.
• Click Import and follow the steps in the Certificate Import Wizard to import the certificates.
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Avoiding Login Overlays if Reply Template Container Loads in
IFRAME in IE
When a SocialMiner reply template container loads in an IFRAME in Internet Explorer, a SocialMiner login
overlay may appear even though SocialMiner successfully authenticated. If the page inside the IFRAME
does not have a privacy policy, cookies are blocked (which is indicated by the red barred circle over the 'eye'
icon in status bar).

Download the certificate file.
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To permit cookies for SocialMiner:
1. Click the eye icon. The Internet Explorer privacy settings dialog box appears and displays the blocked
cookie from SocialMiner.
2. Select the cookie and choose Always allow cookie from this website.
For more information on how to permit cookies, see the Microsoft Windows help site.
Back to Contents

Provisioning
The following table shows the sizing limits for small and large deployments of a single SocialMiner system.
Large deployment

Small deployment

Concurrent Admin Users
Signed In

5

5

Concurrent Agents Signed In

30

30

Configured feeds

200

100

Configured campaigns

100

50

Simultaneous chat sessions

400

120

Simultaneous social media
users

60

30

Days chat transcript storage

30

30

Tags per social contact

20

20

Filters per system

30 (20 max for Bayesian + Author
combined,
10 max for Script filters)
Note: Each filter type has its own
performance implications and
performance depends almost entirely
on what is in the script filter
implementation.

20 (15 max for Bayesian +
Author combined,
5 max for Script filters)
With the same note as for the
large deployment.

Filters per campaign

10 (5 max for Script filters)

10 (5 max for Script filters)

Incoming Rate of Social
Contacts (total per hour)

10,000

10,000

Replies per Twitter Account per 30
Hour
Note: This limit is for a default
polling interval of 5 minutes.
If the polling interval is set lower than 5

30
With the same note as for the
large deployment.

Avoiding Login Overlays if Reply Template Container Loads inIFRAME in IE
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minutes, then the limit
is reduced depending on usage patterns.
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Retention of Saved Chat Transcripts
A meter on the System Administration gadget of the Administration tab shows the current overall
SocialMiner disk usage. The meter shows percent usage and hovering over the meter shows the actual
number of bytes in use (the same data can be retrieved using the serviceability API).
The Purge Settings section of the gadget displays the maximum age a Social Contact can be before it is
automatically purged by the system (default is 30 days).
As chat transcripts comprise the majority of disk usage, users can decide how long they wish to retain Social
Contacts by using the formula below to calculate the amount of disk space required to retain chat transcripts
for one month (assuming the default purge setting of 30 days is kept). Once the average disk space
requirement for a month's worth of chat transcripts is calculated, users can determine if they wish to retain
Social Contacts for the full 30 days and allocate the appropriate disk space accordingly; or they can choose to
purge Social Contacts more frequently.

Note: If SocialMiner starts to run out of disk space, it will purge Social Contacts based on age (the oldest
ones being purged first).
Formula to calculate the number of chats per month:
NUMBER_CHATS_MONTH = ACTIVE_CHAT_TIME_MONTH_IN_MIN / DURATION_CHAT_MIN
where:
ACTIVE_CHAT_TIME_MONTH_IN_MIN is the average number of minutes per month that agents spend
on chat activities. Assuming that agent activity occurs for 8 hours a day, 7 days a week, 4 weeks a month; the
value is 13440 minutes (8*7*4*60).
DURATION_CHAT_MIN is the average duration of a chat in minutes.
Formula to calculate the amount of disk space required per month for chat transcripts:
DISK_SPACE_MONTH = (TR_SIZE + SC_SIZE) * NUMBER_SIMULTANEOUS_CHATS *
NUMBER_CHATS_MONTH
where:
TR_SIZE is the average transcript size in Kbytes.
SC_SIZE is the average size of the metadata for a social contact in Kbytes (which is normally 3 Kbytes).
NUMBER_SIMULTANEOUS_CHATS is the number of simultaneous chats sessions allowed.
NUMBER_CHATS_MONTH is the value calculated above.

Provisioning
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Maximum Network Latency for Chat
The maximum network latency permitted for chat is 250 ms.

Network Bandwidth for Chat
Allocate network bandwidth required for chat based on this formula
CHAT_NETWORK_BANDWIDTH (in Kbps) = CHAT_SESSIONS_SENDING_MSG_PER_SECOND *
AVG_MSG_SIZE
For example, If all 400 sessions are active and 10% of chat sessions are sending messages every second, then
400 * 10/100 = 40 chat sessions are sending message each second.
If the average message size is 1 Kb, then the chat network bandwith is 40 Kbps.

SocialMiner User Accounts and Security
SocialMiner minimizes the storage of username/passwords to reduce the security risk of a compromised
system. There is an administration account for the system setup, but all SocialMiner user access is controlled
through Active Directory (AD) authentication. There are no SocialMiner user passwords stored on the
SocialMiner System.
Users do not need to be manually set up on SocialMiner to access the system. Any user that is authenticated
by the Active Directory set-up can use the system. If limits on who can use system are required, set up an AD
group and configure SocialMiner to only allow access for that group.
AD authenticated users have access to all functions on the system, although gadgets access could be blocked
by blocking certain URLs.
Back to Contents

Twitter Accounts and Security
Access to Twitter for the Twitter Account feed type is done by OAuth. When a "Twitter Account" feed is
created, the user is prompted to authenticate with Twitter. The authentication token is stored by SocialMiner
granting access to secured information from Twitter such as Direct Messages. This authentication also
enables sending and replying to Twitter Direct Messages (DMs) from the account by using the Reply feature
on the Home tab.
Note: All SocialMiner users can use Twitter accounts configured in the Twitter Account feed to read and
respond to Direct Messages in that account. They are not required to enter the account password. This
supports environments where the social-media care agents are not entitled to know the Twitter account
password. The capability to use SocialMiner is controlled by Active Directory. The capability to invoke post
or perform actions on Twitter is controlled by SocialMiner. SocialMiner also tracks which SocialMiner User
(AD account) makes each post. Therefore, it is possible for the enterprise to track which employee posted a
tweet when sharing a Twitter account amongst a team.
Twitter Stream feed type passwords are encrypted when stored in the SocialMiner configuration database and
are also encrypted when sent to Twitter.
Maximum Network Latency for Chat
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VMware Open Virtual Format (OVF)
The SocialMiner system supports one standard OVF Appliance. The VM configuration defined by the OVF
must not be modified in any way. Any changes to the VM configuration are not supported.
SocialMiner 9.0(1) can only be deployed on servers using VMware ESXi 5.0.
See Virtualization for Cisco SocialMiner.
Back to Contents

Developer Information
Developer information, including the SocialMiner API documentation and a discussion forum, is available
on the Cisco developer site. Cisco login credentials are required to access this site.
Training labs are accessed here.

Copyright Notes
• Twitter is a registered trademark of Twitter, Inc.
• Facebook is a registered trademark of Facebook, Inc.
• iGoogle is a trademark of Google, Inc.
• VMware is a registered trademark of VMware, Inc.
• Informix is a registered trademark of International Business Machines Corporation.

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE
SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND
RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL
RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.
THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE
SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE
INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE
LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.
The Cisco implementation of TCP header compression is an adaptation of a program developed by the
University of California, Berkeley (UCB) as part of UCBs public domain version of the UNIX operating
system. All rights reserved. Copyright 1981, Regents of the University of California.
NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF
THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED
SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT
LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.
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IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL,
CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST
PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS
MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF
SUCH DAMAGES.
Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other
countries. A listing of Cisco's trademarks can be found at http://www.cisco.com/go/trademarks. All other
trademarks mentioned in this document or Website are the property of their respective owners. The use of the
word partner does not imply a partnership relationship between Cisco and any other company. (1110R)
Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any
examples, command display output, and figures included in the document are shown for illustrative purposes
only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.
Copyright 2011-2013 Cisco Systems, Inc. All rights reserved.
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